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/\ CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage
to equipment or loss of information.

E%?NOTE: Text set off in this manner provides important supplemental information.
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1 Product features

Standard configuration features

Features may vary depending on the model. For a complete listing of the hardware and software
installed in the computer, run the diagnostic utility (included on some computer models only).

Microtower
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Front panel components

Microtow

Drive configuration may vary by model. Some models have a bezel blank covering one or more drive

bays.

er (model 400/490)

5.25-inch Optical Drive (optional)

Microphone Connector

5.25-inch Half-Height Drive Bay (behind bezel)

Hard Drive Activity Light

3.5-inch Media Card Reader (optional)

USB 3.0 Ports (blue)

4

Dual-State Power Button

Headphone Connector

5

USB 2.0 Ports (black)

NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code.

Front panel components
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Small form factor

Drive configuration may vary by model. Some models have a bezel blank covering one or more drive
bays.

1 Slim Optical Drive (optional) 5  Headphone Connector

2 USB 2.0 Ports (black) 6 Dual-State Power Button

3 USB 3.0 Ports (blue) 7 Hard Drive Activity Light

4 Microphone Connector 8  3.5-inch Media Card Reader (optional)

NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code.
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Rear panel components

Microtower (model 400)

Power Cord Connector

Line-Out Connector for powered audio
devices (green)

2 Power Indicator Light 8 Voltage Select Switch

3 PS/2 Keyboard Connector (purple) 9 & PS/2 Mouse Connector (green)
4 lolola Serial Connector 10 22  RI-45 Network Connector

5 e~ USB 2.0 Ports (black) 11 & VGA Monitor Connector

6 [F@n DVID Monitor Connector 12 aF Line-In Audio Connector (blue)

NOTE: An optional second serial port and an optional parallel port are available from HP.

When a graphics card is installed in one of the system board slots, the video connectors on the graphics card and
the integrated graphics on the system board may be used at the same time. However, for such a configuration, only
the display connected to the discrete graphics card will display POST messages.

The system board graphics can be disabled by changing settings in Computer Setup.

Rear panel components
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Microtower (model 490)

1 Power Cord Connector 8 «f  LineOut Connector for powered audio
devices (green)
2 Power Indicator Light 9 Voltage Select Switch

3 PS/2 Keyboard Connector (purple)

PS/2 Mouse Connector (green)

4 lolola Serial Connector 1M 2% R4S Network Connector
5  8§§<- USB 3.0 Ports (blue) 12 VGA Monitor Connector
6 o USB 2.0 Ports (black) 13 Optional DisplayPort

™

7 @1 DVI-D Monitor Connector

14 »J’

Line-In Audio Connector (blue)

NOTE: An optional second serial port, an optional parallel port, and an optional DisplayPort are available from

HP.

When a graphics card is installed in one of the system board slots, the video connectors on the graphics card and
the integrated graphics on the system board may be used at the same time. However, for such a configuration, only
the display connected to the discrete graphics card will display POST messages.

The system board graphics can be disabled by changing settings in Computer Setup.

Chapter 1 Product features



Small form factor

1 il PS/2 Mouse Connector (green) 6 Power Cord Connector

2 EE  R}45 Network Connector 7 PS/2 Keyboard Connector (purple)

3 lolola Serial Connector 8 [E» DVID Monitor Connectors

4 o<~ USB 2.0 Ports (black) 9 O VGA Monitor Connector

5 af Line-In Audio Connector (blue) 10« Line-Out Connector for powered audio

devices (green)

NOTE: An optional second serial port and an optional parallel port are available from HP.

When a graphics card is installed in one of the system board slots, the video connectors on the graphics card and
the integrated graphics on the system board may be used at the same time. However, for such a configuration, only
the display connected to the discrete graphics card will display POST messages.

The system board graphics can be disabled by changing settings in Computer Setup.

Rear panel components 7



Serial number location

Each computer has a unique serial number and a product ID number that are located on the exterior of
the computer. Keep these numbers available for use when contacting customer service for assistance.

Microtower

Small Form Factor
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2 Activating and Customizing the
Software

E‘/?"NOTE: This chapter provides information for both Windows 7 and Windows 8.

Activating and customizing the software in
Windows 7

If your computer was not shipped with a Windows® operating system, some portions of this
documentation do not apply. Additional information is available in online help after you activate the
operating system.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operatin
P party P P 9
system is successfully activated. Doing so may cause errors and prevent the operating system from
installing properly.

2»NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows operating system

The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

We recommend that you register your computer with HP during operating system setup so you can
receive important software updates, facilitate support questions, and sign up for special offers.

/\ CAUTION: Atfter the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.

r__":"‘/f’NOTE: If the computer shipped with more than one operating system language on the hard drive, the
activation process could take up to 60 minutes.

Activating and customizing the software in Windows 7
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Downloading Windows 7 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions
on the screen.

2. After an Internet connection has been established, click the Start > All Programs > Windows
Update.

3. Run Windows Update monthly thereafter.

Installing or upgrading device drivers

When installing optional hardware devices after the operating system installation is complete, you must
also install the drivers for each of the devices.

In Windows 7, if prompted for the i386 directory, replace the path specification with C:\1386, or use
the Browse button in the dialog box to locate the 1386 folder. This action points the operating system
to the appropriate drivers.

Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display

If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings.

For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.

Right-click on the Windows desktop, then click Personalize to change display settings.

Activating and customizing the software in
Windows 8

Additional information is available in online help after you activate the operating system.

2% NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to

permit the required airflow.

Activating the Windows Operating System

10

The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.
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We recommend that you register your computer with HP during operating system set up so you can
receive important software updates, facilitate support questions, and sign up for special offers. You can
also register your computer with HP using the Register with HP app on the Start screen.

/\ CAUTION: Atfter the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.

Downloading Windows 8 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.
1. Point to the upper-right or lower-right corner of the Start screen to display the charms.
2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Customizing the monitor display

You can customize display settings for Windows 8 separately for the Start screen and the Desktop.
To customize the Start screen:

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings.

3. Click Persondlize to change the display settings.

To customize the Desktop:

1. Click the Desktop app on the Start screen.

2. Rightclick on the desktop, and then click Personalize to change display settings.

Activating and customizing the software in Windows 8 11



3 lllustrated parts catalog

This chapter provides spare part information for all chassis.

2»NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

12 Chapter 3 lllustrated parts catalog
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Item Description Spare part number
(1) Front bezel
For use in all countries and regions except for the People’s Republic of China 745047-001
For use in the People’s Republic of China 745048001
(2) Access panel 745046-001
(3) Power supply
300W, Energy Star 5.0 712298-001
300W, Energy Star 6.0 748824-001
300W, Active PFC 715184-001
Power supply, 300W, active PFC, SEPA 752628-001
300W, regular 715185001
System board (includes replacement thermal material)
NOTE: System board color may vary.
(4) For use in 400 models:
e  For use in models without Windows 8 718413001
e  For use in models with Windows 8 Standard 718413-501
e  For use in models with Windows 8 Professional 718413-601
e  For use in models with NetClone (the People’s Republic of China only) 745238-001
(5) For use in 490 models:
e  For use in models without Windows 8 718412-001
e  For use in models with Windows 8 Standard 718412-501
e  For use in models with Windows 8 Professional 718412-601
e  For use in models with NetClone (the People’s Republic of China only) 745240-001
(6) For use in 480 G1 models:
e  For use in models without Windows 8 747910-001
e  For use in models with Windows 8 Standard 747910-501
e  For use in models with Windows 8 Professional 747910-601
e  For use in models with NetClone (the People’s Republic of China only) 759333-001
Memory modules (PC3,12800, CL11)
8-GB 689375-001
4-GB 671613-001
2-GB 671612-001

Processors (include replacement thermal material)

Chapter 3
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Item Description Spare part number
Intel Core i7 4771 (3.5-GHz, 8-MB L3 cache), 84W 742563-001
Intel Core i7 4770 (3.4-GHz, 8-MB L3 cache), 84W 727373-001
Intel Core i7 4770s (3.1-GHz, 8-MB L3 cache), 65W 732507-001
Intel Core i5 4670 (3.4-GHz, 6-MB L3 cache), 84W 727381-001
Intel Core i5 4670s (3.1-GHz, 6-MB L3 cache), 65W 732506-001
Intel Core i5 4570 (3.2-GHz, 6-MB L3 cache), 84W 727380-001
Intel Core i5 4570s (2.9-GHz, 6-MB L3 cache), 65W 732505-001
Intel Core i5 4430 (3.0-GHz, 6-MB L3 cache), 84W 745033-001
Intel Core i5 4430s (2.7-GHz, 6-MB L3 cache), 65W 745034-001
Intel Core i3 4340 (3.6-GHz, 4-MB L3 cache), 54W 742562-001
Intel Core i3 4330 (3.5-GHz, 4-MB L3 cache), 54W 742561-001
Intel Core i3 4130 (3.4-GHz, 4-MB L3 cache), 54W 742560-001
Intel Pentium G3430 (3.3-GHz, 3-MB L3 cache), 54W 742566-001
Intel Pentium G3420 (3.2-GHz, 3-MB L3 cache), 54W 742565-001
Intel Pentium G3220 (3.0-GHz, 3-MB L3 cache), 54W 742564-001
Intel Celeron G1830 (2.8-GHz, 2-MB L3 cache), 54W 758757-001
Intel Celeron G1820 (2.7-GHz, 2-MB L3 cache), 54W 758756-001
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Cables

Item Description Spare part number

(1) Front 1/0 assembly 745049-001

(2) Power switch/LED assembly 745050-001
SATA data cable, 14 inch, 2 straight ends 745051-001
DMS-59 to dual VGA cable 463023-001
DMS-59 to dual DVI cable 463024-001
Adapter, DisplayPort to VGA 632484-001
Adapter, DisplayPort to DVI 662723-001
Adapter, DisplayPort to HDMI 617450001
Adapter, DVI to VGA 657401-001
Adapter, DVI-I to VGA (BFR/PVC free) 720216001
Adapter, DVI-l to VGA (Standard) 202997-001
DisplayPort cable 487562-001
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Misc parts

Item Description Spare part number
(1) Fan sink (includes replacement thermal material)
For use in 400 and 490 models, standard 745054-001
For use in 490 models, BFR/PVC free 748826-001
(2) Speaker 745053-001
(3) Fan
Standard 745052-001
Fan, BFR/PVC free 748825-001

Microtower chassis spare parts
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Item Description Spare part number

(4) Serial port, PCI card 638815-001
(5) DisplayPort connector module (for use only in 490 MT models) 735966-001
Printer port, PCl card 638817-001

Card reader

14-in-1, USB 3.0, 3.5-inch, UHS 716390-001
15-in-1, USB 3.0, 3.5-inch, UHS-II 736299-001
Adapter, USB 3.0 to 2.0 736835-001
Optical drive bezel blank 745036-001
HP Ultraslim Keyed Cable Lock 703372001
Hard drive carrier, 2.5-inch to 3.5-inch 703597001

Hard drive adapter bracket (to install 2.5” or 3.5” hard drives into 5.25 drive bay) ~ 397117-001

WLAN antennas 583345-001
Mouse

PS2, optical 674315-001
USB, HP Elite 674318-001
Washable 724795-001
Wireless, HP Elite (for use only in Brazil) 674317-001
Mouse, USB 674316-001
Mouse, USB, Portia 719901-001
Keyboards

PS/2 724718-xx1
usB 724720-xx1
Wireless, HP Elite with USB dongle (for use only in Brazil) 724722-201
USB, unbranded, Katydid 729339-xx1
Unbranded 709695-xx1
Smart card, CCID 70167 1-xx1
Wireless keyboard, mouse, and dongle kit (for use in all countries except for Brazil) 730323-xx]1
Washable 700510xx1
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Drives

Description Spare part number
Hard drive

2 TB, 7200 rpm, 3.5 inch 747993-001
1 TB, hybrid SSD 724937-001
1 TB, 7200 rpm, 3.5 inch 747992-001
500 GB, 7200 rpm, 3.5 inch 751283-001
500 GB, hybrid SSD 724938-001
256 GB Solid-state Drive (SSD), self-encrypting (SED) 680020-001
180 GB Solid-state Drive (SSD) 754076-001
128 GB Solid-state Drive (SSD) 665961-001
120 GB Solid-state Drive (SSD) 756459-001
20 GB Solid-state Drive (SSD) 683305-001

Optical drive

Blu-ray BD-RW SuperMulti XL Drive 682219001
DVD+RW drive 690418-001
DVD-ROM drive 682550-001

Misc boards

Description Spare part number
Nvidia NVS310 PCle x16 graphics card, 512 MB 707252-001
Nvidia NVS315 PCle x16 graphics card, 1 GB 720837-001
AMD Radeon HD8490 DP PCle x16 graphics card, 1 GB 717219001
AMD Radeon HD8470 PCle x16 graphics card, 2 GB (for use only in the People’s Republic of 729085-001
China)

AMD Radeon HD8350 DH PCle x16 graphics card, 1 GB DDR3 717220001
AMD Radeon HD8350 PCle x16 graphics card, 1 GB DDR3 (for use only in the People’s Republic ~ 729084-001
of China)

Nvidia GeForce GT630 DP PCle x16 graphics card, 2 GB 702084-001
Intel PRO/1000 single port GbE NIC, includes bracket 728562-001
Intel Dual Band Wireless-N 7260 802.11 a/b/g/n (2x2) Wireless NIC 745668-001
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Sequential part number listing

Spare part  Description
number

202997001  Adapter, DVH to VGA (standard)

397117-001  Hard drive adapter bracket (to install 2.5” or 3.5” hard drives into 5.25 drive bay)

450712001 Grommet, hard drive

463023-001 DMS-59 to dual VGA cable

463024-001 DMS-59 to dual DVI cable

487562-001  DisplayPort cable

583345-001 WLAN antennas

586721001  Drive adapter, 2.5 inch

617450001  Adapter, DisplayPort to HDMI

632484-001  Adapter, DisplayPort to VGA

638815001  Serial port PCl card

638817001  Printer port, PCl card

657401-001  Adapter, DVI to VGA

660408-001 DVD+RW drive

662723001  Adapter, DisplayPort to DVI

665961-001 128-GB Solid-state drive

671612001 Memory module, 2-GB, PC3 12800

671613001  Memory module, 4-GB, PC3-12800

674315-001 Mouse, PS2, optical

674316-001 Mouse, USB, optical

674317-001  Mouse, wireless (for use only in Brazil)

674318-001  Mouse, USB

680020-001 256 GB Solid-state drive, self-encrypting (SED)

682219001  Blu-ray BD-RW SuperMulti XL Drive

682550-001 DVD-ROM drive

683305-001 20 GB Solid-state drive

689375001  Memory module, 8-GB, PC3-12800

690418-001 DVD+RW drive

700510-xx]1 Washable keyboard

70167 1-xx1 Keyboard, smart card, CCID
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Spare part  Description

number

702084-001  Nvidia GeForce GT630 DP PCle x16 graphics card, 2 GB

703372001  HP Ultraslim Keyed Cable Lock

703597-001 Hard drive carrier, 2.5-inch to 3.5-inch

707252001  Nvidia NVS310 PCle x16 graphics card, 512 MB

709695-xx]1 Keyboard, unbranded

712298-001  Power supply for use in the microtower, 300W, Energy Star 5.0

715184-001  Power supply for use in the microtower, 300W, Active PFC

715185001  Power supply for use in the microtower, 300W, regular

716390-001 Card reader, 14-in-1, USB 3.0, 3.5-inch, UHS

717219001  AMD Radeon HD8490 DP PCle x16 graphics card, 1 GB

717220001  AMD Radeon HD8350 DH PCle x16 graphics card, 1 GB DDR3

718412-001  System board for use in 490 models without Windows 8 (includes replacement thermal material)
718412501  System board for use in 490 models with Windows 8 Standard (includes replacement thermal material)
718412-601  System board for use in 490 models with Windows 8 Professional (includes replacement thermal material)
718413-001  System board for use in 400 models without Windows 8 (includes replacement thermal material)
718413-501  System board for use in 400 models with Windows 8 Standard (includes replacement thermal material)
718413-601  System board for use in 400 models with Windows 8 Professional (includes replacement thermal material)
719901-001 Mouse, USB, Portia

720216-001 Adapter, DVH to VGA (BFR/PVC free)

720837-001  Nvidia NVS315 PCle x16 graphics card, 1 GB

724718xx1 Keyboard, PS/2, for use in models with Windows 8

724720-xx1 Keyboard, USB, black, for use in models with Windows 8

724722201  Keyboard, wireless, HP Elite with USB dongle (for use only in Brazil)

724795-001 Mouse, washable

724937-001 1 TB hard drive, hybrid SSD

724938-001 500 GB hard drive, hybrid SSD

727373-001 Intel Core i7 4770 processor (3.4-GHz, 8-MB L3 cache)

727380-001 Intel Core i5 4570 processor (3.2-GHz, 6-MB L3 cache)

727381-001 Intel Core i5 4670 processor (3.4-GHz, 6-MB L3 cache)

728562-001 Intel PRO/1000 single port GbE NIC, includes bracket

729084-001  AMD Radeon HD8350 PCle x16 graphics card, 1 GB (for use only in the People’s Republic of China)
729085-001  AMD Radeon HD8470 PCle x16 graphics card, 2 GB (for use only in the People’s Republic of China)
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Spare part  Description

number

729339-001 Keyboard, USB, unbranded, Katydid

730323-xx1 Wireless keyboard, mouse, and dongle kit (for use in all countries except for Brazil)

732505-001 Intel Core i5 4570s processor (2.9-GHz, 6-MB L3 cache), 65W

732506-001 Intel Core i5 4670s processor (3.1-GHz, 6-MB L3 cache), 65W

732507-001 Intel Core i7 4770s processor (3.1-GHz, 6-MB L3 cache), 65W

735966-001  DisplayPort connector module (for use only in 480 MT and 490 MT models)

736299-001 Card reader, 15-in-1, USB 3.0, 3.5-inch, UHS-II

736835-001  Adapter, USB 3.0 to 2.0

742560-001 Intel Core i3 4130 processor (3.4-GHz, 4-MB L3 cache), 54W

742561-001 Intel Core i3 4330 processor (3.5-GHz, 4-MB L3 cache), 54W

742562-001 Intel Core i3 4340 processor (3.6-GHz, 4-MB L3 cache), 54W

742563-001 Intel Core i7 4771 processor (3.5-GHz, 8-MB L3 cache), 84W

742564-001 Intel Pentium G3220 processor (3.0-GHz, 3-MB L3 cache), 54W

742565-001 Intel Pentium G3420 processor (3.2-GHz, 3-MB L3 cache), 54W

742566-001 Intel Pentium G3430 processor (3.3-GHz, 3-MB L3 cache), 54W

745033-001 Intel Core i5 4430 processor (3.0-GHz, 6-MB L3 cache), 84W

745034-001 Intel Core i5 4430s processor (2.7-GHz, 6-MB L3 cache), 65W

745036-001  Optical drive bezel blank

745046-001  Access panel

745047-001  Front bezel for use in all countries and regions except for the People’s Republic of China

745048-001  Front bezel for use in the People’s Republic of China

745049001  Front I/O assembly

745050-001 Power switch/LED with holder

745051-001 SATA data cable, 14 inch, 2 straight ends

745052-001 Rear chassis fan, standard

745053-001  Speaker

745054-001  Fan sink for use in 400 MT and 490 MT models

745238001  System board for use in 400 MT models with NetClone (includes replacement thermal material) (the People’s
Republic of China only)

745240001  System board for use in 490 MT models with NetClone (includes replacement thermal material) (the People’s
Republic of China only)

745668-001 Intel Dual Band Wireless-N 7260 802.11 a/b/g/n (2x2) Wireless NIC

747910001  System board for use in 480 G1 models without Windows 8 (includes replacement thermal material)
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Spare part  Description

number

747910-501  System board for use in 480 G1 models with Windows 8 Standard (includes replacement thermal material)

747910-601  System board for use in 480 G1 models with Windows 8 Professional (includes replacement thermal
material)

747992-001 1 TB, 7200 rpm hard drive, 3.5 inch

747993-001 2 TB, 7200 rpm SATA hard drive, 3.5 inch

748824001  Power supply for use in the microtower, 300W, Energy Star 6.0

748825-001 Rear chassis fan, BFR/PVC free

748826-001 Fan sink for use in 490 models, BFR/PVC free

751283-001 500 GB, 7200 rpm SATA hard drive, 3.5 inch

752628001  Power supply, 300W, active PFC, SEPA

754076-001 180-GB Solid-state drive

756459-001 120-GB Solid-state drive

758756-001 Intel Celeron G1820 processor (2.8-GHz, 2-MB L3 cache), 54W

758757-001 Intel Celeron G1830 processor (2.7-GHz, 2-MB L3 cache), 54W

759333-001  System board for use in 480 G1 MT models with NetClone (includes replacement thermal material) (the

People’s Republic of China only)
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Small Form Factor chassis spare parts

Computer major components

R RT | ] ]

Item Description Spare part number

(1) Front bezel 745039-001
(2) Access panel 745042-001
(3) Power supply
240W, 85% efficient 722536-001
240W, standard 702457-001
(4) System board (includes replacement thermal material)
718414-001

For use in models without Windows 8
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Item Description Spare part number
For use in models with Windows 8 Standard 718414-501
For use in models with Windows 8 Professional 718414-601
For use in models with NetClone (the People’s Republic of China only) 745239-001
Memory modules (PC3,12800, CL11)
8-GB 689375-001
4-GB 671613-001
2-GB 671612-001
Processors (include replacement thermal material)

Intel Core i7 4771 (3.5-GHz, 8-MB L3 cache), 84W 742563-001
Intel Core i7 4770 (3.4-GHz, 8-MB L3 cache), 84W 727373-001
Intel Core i7 4770s (3.1-GHz, 8-MB L3 cache), 65W 732507-001
Intel Core i5 4670 (3.4-GHz, 6-MB L3 cache), 84W 727381-001
Intel Core i5 4670s (3.1-GHz, 6-MB L3 cache), 65W 732506-001
Intel Core i5 4570 (3.2-GHz, 6-MB L3 cache), 84W 727380-001
Intel Core i5 4570s (2.9-GHz, 6-MB L3 cache), 65W 732505-001
Intel Core i5 4430 (3.0-GHz, 6-MB L3 cache), 84W 745033-001
Intel Core i5 4430s (2.7-GHz, 6-MB L3 cache), 65W 745034-001
Intel Core i3 4340 (3.6-GHz, 4-MB L3 cache), 54W 742562-001
Intel Core i3 4330 (3.5-GHz, 4-MB L3 cache), 54W 742561-001
Intel Core i3 4130 (3.4-GHz, 4-MB L3 cache), 54W 742560-001
Intel Pentium G3430 (3.3-GHz, 3-MB L3 cache), 54W 742566-001
Intel Pentium G3420 (3.2-GHz, 3-MB L3 cache), 54W 742565-001
Intel Pentium G3220 (3.0-GHz, 3-MB L3 cache), 54W 742564-001
Intel Celeron G1830 (2.8-GHz, 2-MB L3 cache) 758757-001
Intel Celeron G1820 (2.7-GHz, 2-MB L3 cache) 758756-001

Small Form Factor chassis spare parts
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Cables

| Ay

Item Description Spare part number

(1 Front /O assembly 745037-001

(2) Power switch assembly 745038-001
SATA drive power cable 745040-001
SATA data cable, 19.5 inch, 2 straight ends 745044-001
SATA data cable, 14.0 inch, 1 straight end, 1 right angle 745045001
DMS-59 to dual VGA cable 463023-001
Adapter, DisplayPort to VGA 632484-001
Adapter, DisplayPort to DVI 662723-001
Adapter, DisplayPort to HDMI 617450001
Adapter, DVI to VGA 657401-001
Adapter, DVI-I to VGA (BFR/PVC free) 720216-001
Adapter, DVI-I to VGA (Standard) 202997-001
DisplayPort cable 487562-001
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Misc parts

ltem Description Spare part number
(1) Fan sink (includes replacement thermal material) 745661-001
(2) Speaker 727149001
(3) Printer port, PCl card 638817-001
(4) Fan duct 727145-001
(5) Serial port, PCI card 638815-001
Card reader
Card reader, 14-in-1, USB 3.0, 3.5-inch, UHS-I 716390-001
Card reader, 15-in-1, USB 3.0, 3.5-inch, UHSHI 736299-001
Adapter, USB 3.0 to 2.0 736835001
Optical drive bezel blank 732769-001
HP Ultraslim Keyed Cable Lock 703372-001
Rubber foot 583654-001
Chassis stand 688952001
Hard drive carrier, 2.5-inch to 3.5-inch 703597001

Small Form Factor chassis spare parts
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Item Description Spare part number

Hard drive adapter bracket (to install 2.5” or 3.5” hard drives into 5.25 drive bay) ~ 397117-001

WLAN antennas 583345-001
Mouse
PS2, optical 674315-001
USB, HP Elite 674318-001
Washable 724795001
Wireless, HP Elite (for use only in Brazil) 674317-001
USB, optical 674316001
USB, Portia 719901-001
Foot kit 583654-001
Keyboard
PS/2 724718-xx1
usB 724720-xx1
Wireless, HP Elite with USB dongle (for use only in Brazil) 724722-201
Unbranded 709695-xx1
USB, unbranded, Katydid 729339-xx1
Smart card, CCID 70167 1-xx1
Wireless keyboard, mouse, and dongle kit (for use in all countries except for Brazil) 730323-xx]1
Washable 700510-xx]1
Drives
Description Spare part number
Hard drive
2 TB, 7200 rpm, 3.5 inch 747993-001
1 TB hard drive, hybrid SSD 724937-001
1 TB, 7200 rpm, 3.5 inch 747992-001
500 GB, 7200 rpm, 3.5 inch 751283-001
500 GB hard drive, hybrid SSD 724938001
256-GB Solid-state Drive (SSD), self-encrypting (SED) 680020-001
180-GB Solid-state drive 754076001
128-GB Solid-state Drive (SSD) 665961-001
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Description Spare part number
120-GB Solid-state drive 756459001

20-GB Solid-state Drive (SSD) 683305-001

Optical drive

Blu-ray BD-RW SuperMulti XL Drive 719157001
DVD+RW drive 657958-001
DVD-ROM drive 608394-001

E‘%NOTE: 2.5-inch solid-state drives require an adapter for installation.

Misc boards

Description Spare part number
Nvidia NVS310 PCle x16 graphics card, 512 MB 707252-001
Nvidia NVS315 PCle x16 graphics card, 1 GB 720837-001
AMD Radeon HD8490 DP PCle x16 graphics card, 1 GB 717219001
AMD Radeon HD8350 DH PCle x16 graphics card, 1 GB DDR3 717220001
Intel PRO/1000 single port GbE NIC, includes bracket 728562-001
Intel Dual Band Wireless-N 7260 802.11 a/b/g/n (2x2) Wireless NIC 745668-001

Sequential part number listing

Spare part Description

number

202997-001  Adapter, DVH to VGA (standard)
397117-001  Hard drive adapter bracket (to install 2.5” or 3.5” hard drives into 5.25 drive bay)
463023-001  DMS-59 to dual VGA cable
487562001  DisplayPort cable

583345-001  WILAN antennas

583654-001  Rubber foot

608394-001  DVD-ROM drive

617450001  Adapter, DisplayPort to HDMI
632484-001  Adapter, DisplayPort to VGA
638815-001  Serial port PCl card

Small Form Factor chassis spare parts
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Spare part  Description

number

638817-001  Printer port, PCl card

657401-001  Adapter, DVl to VGA

657958-001 DVD+RW drive

662723001  Adapter, DisplayPort to DVI

665961-001  128-GB Solid-state drive

671612-001 Memory module, 2-GB, PC3 12800

671613-001 Memory module, 4-GB, PC3-12800

674315-001 Mouse, PS2, optical

674316-001  Mouse, USB, optical

674317001  Mouse, wireless, HP Elite (for use only in Brazil)

674318-001 Mouse, USB, HP Elite

680020-001  256-GB Solid-state drive, self-encrypting (SED)

683305-001  20-GB Solid-state drive

688952-001  Chassis stand

689375-001 Memory module, 8-GB, PC3-12800

700510-xx]1 Woashable keyboard

70167 1xx1 Keyboard, smart card, CCID

702457-001  Power supply, 240W, 85% efficient

703372001  HP Ultraslim Keyed Cable Lock

703597-001 Hard drive carrier, 2.5-inch to 3.5-inch

707252-001  Nvidia NVS310 PCle x16 graphics card, 512 MB

709695-xx1 Keyboard, unbranded

716390-001 Card reader, 14-in-1, USB 3.0, 3.5-inch, UHS-I

717219001  AMD Radeon HD8490 DP PCle x16 graphics card, 1 GB
717220001  AMD Radeon HD8350 DH PCle x16 graphics card, 1 GB DDR3
718414001  System board for use in models without Windows 8 (includes replacement thermal material)
718414501  System board for use in models with Windows 8 Standard (includes replacement thermal material)
718414-601  System board for use in models with Windows 8 Professional (includes replacement thermal material)
719157-001  Blu-ray BD-RW SuperMulti XL Drive

719901-001 Mouse, USB, Portia

720216-001 Adapter, DV to VGA (BFR/PVC free)

720837-001  Nvidia NVS315 PCle x16 graphics card, 1 GB
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Spare part  Description

number

722536-001  Power supply, 240W, 85% efficient

724718-xx1 Keyboard, PS/2, for use in models with Windows 8
724720-xx1 Keyboard, USB, black, for use in models with Windows 8
724722201  Keyboard, wireless, HP Elite with USB dongle (for use only in Brazil)
724795-001 Mouse, washable

724937-001 1 TB hard drive, hybrid SSD

724938-001 500 GB hard drive, hybrid SSD

727145-001 Fan duct

727149-001  Speaker

727373-001 Intel Core i7 4770 processor (3.4-GHz, 8-MB L3 cache)
727380-001 Intel Core i5 4570 processor (3.2-GHz, 6-MB L3 cache)
727381-001 Intel Core i5 4670 processor (3.4-GHz, 6-MB L3 cache)
728562001 Intel PRO/1000 single port GbE NIC, includes bracket
729339-xx1 Keyboard, USB, unbranded, Katydid

732505-001 Intel Core i5 4570s processor (2.9-GHz, 6-MB L3 cache), 65W
732506-001 Intel Core i5 4670s processor (3.1-GHz, 6-MB L3 cache), 65W
732507-001 Intel Core i7 4770s processor (3.1-GHz, 6-MB L3 cache), 65W
732769-001  Optical drive bezel blank

736835-001 Adapter, USB 3.0 t0 2.0

742560-001 Intel Core i3 4130 processor (3.4-GHz, 4-MB L3 cache), 54W
742561-001 Intel Core i3 4330 processor (3.5-GHz, 4-MB L3 cache), 54W
742562-001 Intel Core i3 4340 processor (3.6-GHz, 4-MB L3 cache), 54W
742563-001 Intel Core i7 4771 processor (3.5-GHz, 8-MB L3 cache), 84W
742564-001 Intel Pentium G3220 processor (3.0-GHz, 3-MB L3 cache), 54W
742565-001 Intel Pentium G3420 processor (3.2-GHz, 3-MB L3 cache), 54W
742566-001 Intel Pentium G3430 processor (3.3-GHz, 3-MB L3 cache), 54W
745033-001 Intel Core i5 4430 processor (3.0-GHz, 6-MB L3 cache), 84W
745034-001 Intel Core i5 4430s processor (2.7-GHz, 6-MB L3 cache), 65W
745037-001 Front I/O cable assembly

745038-001  Power switch assembly

745039-001  Front bezel

745040-001  SATA drive power cable
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Spare part  Description

number

745042001  Access panel

745239-001  System board for use in models with NetClone (includes replacement thermal material) (the People’s Republic
of China only)

745044-001 Optical drive SATA cable, 19.5 inch, 2 straight ends

745045-001  SATA datfa cable, 14.0 inch, 1 straight end, 1 right angle

745661001  Fan sink

745668-001 Intel Dual Band WirelesssN 7260 802.11 a/b/g/n (2x2) Wireless NIC

747992-001 1 TB, 7200 rpm hard drive, 3.5 inch

747993-001 2 TB, 7200 rpm SATA hard drive, 3.5 inch

751283-001 500 GB, 7200 rpm hard drive, 3.5 inch

754076-001 180-GB Solid-state drive

756459001 120-GB Solid-state drive

758756-001 Intel Celeron G1820 processor (2.8-GHz, 2-MB L3 cache), 54W

758757-001 Intel Celeron G1830 processor (2.7-GHz, 2-MB L3 cache), 54W
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4 Rovutine care, SATA drive
guidelines, and disassembly
preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

/\ CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Electrostatic discharge information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.
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Generating static

The following table shows that:

o Different activities generate different amounts of static electricity.
e  Static electricity increases as humidity decreases.
Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000 V 12,000 V
Motions of bench worker 400V 800V 6,000 V
Removing DIPs from plastic tube 400 V 700 V 2,000 V
Removing DIPs from vinyl tray 2,000 V 4,000 V 11,500V
Removing DIPs from Styrofoam 3,500 V 5,000 V 14,500 V
Removing bubble pack from PCB 7,000 V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

[By NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their container.

Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.
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Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one-megohm + 10% resistance between the operator and
ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the work area

To prevent static damage at the work areaq, use the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers fo give added protection.

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at staticfree work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.
Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment

Materials and equipment that are recommended for use in preventing static electricity include:

Antistatic tape
Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids
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Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating guidelines

To prevent overheating and to help prolong the life of the computer:

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented
sides of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

Never operate the computer with the cover or side panel removed.

Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must
be provided on the enclosure, and the same operating guidelines listed above will still apply.

Keep liquids away from the computer and keyboard.
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Never cover the ventilation slots on the monitor with any type of material.

Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care

General cleaning safety precautions

1.
2,

3.
4.
5.
6.

Never use solvents or flammable solutions to clean the computer.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.
Always unplug the computer before cleaning the keyboard, mouse, or air vents.
Disconnect the keyboard before cleaning it.

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General cleaning safety precautions on page 37 before cleaning the
computer.

To clean the computer case, follow the procedures described below:

To remove light stains or dirt, use plain water with a clean, lintfree cloth or swab.

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

After cleaning, always wipe the unit with a clean, lintfree cloth.

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 37 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 37.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions

on page 37 before following these procedures:
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/\ CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

e Visible debris underneath or between the keys may be removed by vacuuming or shaking.

e Canned, pressurized air may be used to clean debris from under the keys. Caution should be used
as too much air pressure can dislodge lubricants applied under the wide keys.

e If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.

/\ CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

e Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor

e  Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

e To clean the monitor body follow the procedures in Cleaning the Computer Case on page 37.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

e  Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 37.

Service considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power supply fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

/\ CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.
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Tools and software Requirements

To service the computer, you need the following:

e Torx T-15 screwdriver

e Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)
e  Flatbladed screwdriver (may sometimes be used in place of the Torx screwdriver)
e  Phillips #2 screwdriver

e Diagnostics software

e  Tamper-esistant T-15 wrench

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with the
part that was removed, then returned to their proper locations.

/\ CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care
to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot be
caught or snagged by parts being removed or replaced.

/\ CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

e If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

e Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

e  Avoid dropping drives from any height onto any surface.
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e If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

e Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector.

e Do not use excessive force when inserting a drive.
e  Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic

fields such as monitors or speakers.

Lithium coin cell battery

The battery that comes with the computer provides power to the realtime clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide
for instructions on the replacement procedures.

/A WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140°F (60°C). Do not attempt to recharge the
battery.

I%NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.

SATA hard drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)
Data interface voltage differential 400-700 mV
Drive voltages 3.3V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 6.0 Gb/s

40 Chapter 4 Routine care, SATA drive guidelines, and disassembly preparation



SATA hard drive cables

SATA data cable

Always use an HP approved SATA 6.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 6.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never
bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SMART ATA drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Cable management

Always follow good cable management practices when working inside the computer.
e Keep cables away from major heat sources like the heat sink.

e Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

e Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when
the parts are moved.

e  When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

e Some flat ribbon cables come prefolded. Never change the folds on these cables.
e Do not bend any cable sharply. A sharp bend can break the internal wires.

e Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

e Never crease a SATA data cable.

e Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.
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5 Removal and replacement
procedures: Microtower

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility o verify
that all components operate properly.

@NOTE: Not all features listed in this guide are available on all computers.

2»NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Preparation for disassembly

See Routine care, SATA drive guidelines, and disassembly preparation on page 33 for initial safety
procedures.

1. Remove/disengage any security devices that prohibit opening the computer.
2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

/\ CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

5. As applicable, lay the computer down on its side to achieve a safe working position.

2»NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

/\ CAUTION: The screws used in the computer are of different thread sizes and lengths; using the
wrong screw in an application may damage the unit.
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Access panel

Description Spare part number

Access panel 745046-001

To access internal components, you must remove the access panel:

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Lloosen the two thumbscrews on the rear of the computer (1) then slide the panel back (2) and lift if
off the computer (3).
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Front bezel

Description Spare part number
Front bezel for use in all countries and regions except for the People’s Republic of China 745047001
Front bezel for use in the People’s Republic of China 745048001

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43)

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).
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Bezel blanks

Description Spare part number

Bezel blank 745036-001

On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch drive bays that need to
be removed before installing a drive. To remove a bezel blank:

1. Remove the access panel (Access panel on page 43)

2. Remove the front bezel (Front bezel on page 44)

3. Remove the bezel blank for the appropriate drive:

e Toremove a 5.25-inch bezel blank, press inward on the two retaining tabs on the side of the
bezel blank that hold the bezel blank in place (1) and rotate the bezel blank back to remove
it (2).
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e Toremove a 3.5-inch bezel blank, press inward on the two retaining tabs on the side of the
bezel blank that hold the bezel blank in place (1) and rotate the bezel blank back to remove
it (2).
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Memory

Description Spare part number
8-GB, PC3-12800 689375-001
4-GB, PC3-12800 671613-001
2-GB, PC3-12800 671612-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DIMMs

The memory sockets on the system board can be populated with up to two industry-standard DIMMs
(model 400) or four industry-standard DIMMs (model 490) . These memory sockets are populated with
at least one preinstalled DIMM. To achieve the maximum memory support, you can populate the system
board with up to 16-GB (model 400) or 32-GB (model 490) of memory configured in a high-
performing dual channel mode.

DDR3-SDRAM DIMMs

For proper system operation, the DDR3-SDRAM DIMMs must be:

e industry-standard 240-pin

e unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant
e 1.35voltor 1.5 volt DDR3/DDR3L-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

e support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)
e  contain the mandatory JEDEC SPD information

In addition, the computer supports:

e  512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies
e singlessided and double-sided DIMMs

e DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

@NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM sockets (Model 400)

There are two DIMM sockets on the system board, with one socket per channel. The sockets are labeled
DIMM1 and DIMM3. Socket DIMM1 operates in memory channel B. Socket DIMM3 operates in
memory channel A.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

@NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior
graphics performance.

The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

The system will operate in a higher-performing dual channel mode if the memory capacity of the
DIMM in Channel A is equal to the memory capacity of the DIMM in Channel B.

The system will operate in flex mode if the memory capacity of the DIMM in Channel A is not
equal to the memory capacity of the DIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. If one channel will have more memory than the
other, the larger amount should be assigned to Channel A.

In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Populating DIMM sockets (Model 490)
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There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMM2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM?2 operate in memory
channel B. Sockets DIMM3 and DIMM4 operate in memory channel A.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

2»NOTE: Single channel and unbalanced dual channel memory contigurations will result in inferior
graphics performance.

The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

The system will operate in a higher-performing dual channel mode if the total memory capacity of
the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The
technology and device width can vary between the channels. For example, it Channel A is
populated with two 1-GB DIMMs and Channel B is populated with one 2-GB DIMM, the system

will operate in dual channel mode.

The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to dual
channel and the remainder is assigned to single channel. For optimal speed, the channels should
be balanced so that the largest amount of memory is spread between the two channels. If one
channel will have more memory than the other, the larger amount should be assigned to Channel
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A. For example, if you are populating the sockets with one 2-GB DIMM, and three 1-GB DIMMs,
Channel A should be populated with the 2-GB DIMM and one 1-GB DIMM, and Channel B should
be populated with the other two 1-GB DIMMs. With this configuration, 4-GB will run as dual
channel and 1-GB will run as single channel.

e In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

/A CAUTION:  You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43)

3. Open both latches of the memory module socket (1), and insert the memory module into the

socket (2).

@NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

Populate the black DIMM sockets before the white DIMM sockets.

For maximum performance, populate the sockets so that the memory capacity is spread as equally
as possible between Channel A and Channel B.
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4. Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

5. Repeat steps 3 and 4 to install any additional modules.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion cards

Description Spare part number
Nvidia NVS310 PCle x16 graphics card, 512 MB 707252001
Nvidia NVS315 PCle x16 graphics card, 1 GB 720837001
AMD Radeon HD8490 DP PCle x16 graphics card, 1 GB 717219001
AMD Radeon HD8470 PCle x16 graphics card, 2 GB (for use only in the People’s Republic of 702085-001
China)

AMD Radeon HD8350 DH PCle x16 graphics card, 1 GB DDR3 717220-001
Nvidia GeForce GT630 DP PCle x16 graphics card, 2 GB 702084-001
AMD Radeon HD8350 PCle x16 graphics card, 1 GB (for use only in the People’s Republic of 729084-001
China)

Intel PRO/1000 single port GbE NIC, includes bracket 728562-001

The computer has three PCl Express x1 expansion slots and one PCl Express x16 expansion slot.

r__":"‘/f’NOTE: You can install a PCl Express x1, x8, or x16 expansion card in the PCI Express x16 slot.

For dual graphics card configurations, the first (primary) card must be installed in the PCI Express x16
slot.

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43)
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3. Remove the screw that holds down the expansion card retention latch (1) then slide the latch up
(2) and pull it off the rear of the chassis (3).

4. Llocate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

2»NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.
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@’NOTE: System board appearance and PCl expansion sockets may vary.

If you are installing an expansion card in a vacant socket, you must slide one of the
expansion slot covers up and out of the chassis or use a flatblade screwdriver to pry out one
of the metal shields on the rear panel that covers the expansion slot. Be sure to remove the
appropriate shield for the expansion card you are installing.

If you are removing a standard PCl card or PCl Express x1 card, hold the card at each end
and carefully rock it back and forth until the connectors pull free from the socket. Lift the card
straight up (1) then away from the inside of the chassis (2) to remove it. Be sure not to scrape
the card against other components.
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c. If you are removing a PCl Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Lift the card straight up then away from the inside of the
chassis to remove it. Be sure not to scrape the card against other components.

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open

slot.

/\ CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.
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8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis (1) so that the bottom of the bracket on
the card slides into the small slot on the chassis. Press the card straight down into the expansion
socket on the system board (2).

2¥»NOTE:  When installing an expansion card, press firmly on the card so that the whole connector
seats properly in the expansion card slot.

9. Press the expansion card retention latch against the back of the chassis (1) and slide it down (2)
so that the tabs on the back of the latch slide into the notches on the chassis and then replace the
screw that secures the latch (3).

10. Connect external cables to the installed card, if needed. Connect internal cables to the system

board, if needed.
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System board connections - model 400

Refer to the following illustration and table to identify the system board connectors for your model.

No. System Board Connector System Board Label Color Component

1 PCl Express x1 X1PCIEXP3 black Expansion Card

2 PCI Express x1 X1PCIEXP2 black Expansion Card

3 PCI Express x1 X1PCIEXP1 black Expansion Card

4 PCl Express x16 X16PCIEXP black Expansion Card

5 Serial Port COMB black Optional Second Serial Port

6 DIMM3 (Channel A) DIMM3 black Memory Module

7 DIMM1 (Channel B) DIMM1 black Memory Module

8 SATA 2.0 SATA4 white Optical Drive

9 SATA 2.0 SATA5 white Optical Drive

10 SATA 3.0 SATAO dark blue Primary Hard Drive

11 SATA 3.0 SATAI light blue Secondary Hard Drive

12 Parallel Port PAR black Optional Parallel Port

13 USB 2.0 MEDIA black USB 2.0 Device, such as a Media
Card Reader

14 Battery BAT black Battery
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System board connections - model 480

Refer to the following illustration and table to identify the system board connectors for your model.

No. System Board Connector System Board Label Color Component

1 PCI PCI white Expansion Card

2 PCl Express x1 X1PCIEXP2 black Expansion Card

3 PCl Express x1 X1PCIEXP1 black Expansion Card

4 PCl Express x16 X16PCIEXP black Expansion Card

5 Serial Port COMB black Optional Second Serial Port

6 DIMM3 (Channel B) DIMM3 black Memory Module

7 DIMM1 (Channel A) DIMM1 black Memory Module

8 Battery BAT black Battery

9 SATA 3.0 SATA4 white Any SATA Device other than the
Primary Hard Drive

10 SATA3.0 SATA5 white Any SATA Device other than the
Primary Hard Drive

11 SATA 3.0 SATA1 dark blue Primary Hard Drive

12 SATA 3.0 SATA2 light blue Any SATA Device other than the

Primary Hard Drive
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No. System Board Connector System Board Label Color Component
13 Parallel Port PAR black Optional Parallel Port
14 USB 2.0 UsB black USB 2.0 Device, such as a Media

Card Reader

System board connections - model 490
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Refer to the following illustration and table to identify the system board connectors for your model.

No. System Board Connector System Board Label Color Component

1 PCl Express x1 X1PCIEXP3 black Expansion Card

2 PCI Express x1 X1PCIEXP2 black Expansion Card

3 PCI Express x1 X1PCIEXP1 black Expansion Card

4 PCl Express x16 X16PCIEXP black Expansion Card

5 DisplayPort DISPLAY white DisplayPort Expansion Card

6 Serial Port COMB black Optional Second Serial Port

7 DIMM4 (Channel A) DIMM4 white Memory Module

8 DIMM3 (Channel A) DIMM3 black Memory Module

9 DIMM?2 (Channel B) DIMM?2 white Memory Module

10  DIMM1 (Channel B) DIMM1 black Memory Module

11 SATA 3.0 SATA4 light blue Any SATA Device other than the
Primary Hard Drive

12 SATA 3.0 SATA5 light blue Any SATA Device other than the

Primary Hard Drive
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No. System Board Connector System Board Label Color Component

13 SATA 3.0 SATAO dark blue Primary Hard Drive

14 SATA 3.0 SATAI light blue Any SATA Device other than the
Primary Hard Drive

15 Parallel Port PAR black Optional Parallel Port

16 USB 3.0 MEDIA 3.0 black USB 3.0 Device, such as a Media
Card Reader

17  USB 2.0 MEDIA black USB 2.0 Device, such as a Media
Card Reader

18  Battery BAT black Battery

L]
Drives
Description Spare part number

Optical drives

DVD+RW drive 690418-001
DVD-ROM drive 682550-001
Blu-ray BD-RW SuperMulti XL Drive 682219-001

Hard drives

2 TB, 7200 rpm hard drive, 3.5 inch 747993-001
1 TB hard drive, hybrid SSD 724937-001
1 TB, 7200 rpm hard drive, 3.5 inch 747992-001
500 GB, 7200 rpm hard drive, 3.5 inch 751283-001
500 GB hard drive, hybrid SSD 724938-001
256 GB Solid State Drive (SSD), self-encrypting (SED) 680020-001
180 GB Solid State Drive (SSD) 754076-001
128 GB Solid State Drive (SSD) 665961-001
120 GB Solid State Drive (SSD) 756459-001
20 GB Solid State Drive (SSD) 683305-001

Card reader

14-in-1, USB 3.0, 3.5-inch, UHSI 716390-001
15-in-1, USB 3.0, 3.5-inch, UHS-II 736299-001
Adapter, USB 3.0 to 2.0 736835-001
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When installing drives, follow these guidelines:

Model 400:

e The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATAO.

e  Connect a secondary hard drive to the light blue SATA connector on the system board labeled
SATAT,

e  Connect optical drives to the white SATA connectors on the system board labeled SATA4 and
SATAS.

e Connect a media card reader USB 3.0 cable to a USB 3.0 to USB 2.0 adapter and connect the
adapter to the black USB 2.0 connector on the system board labeled MEDIA.

e The power cable for the drives has two branches coming out of the power supply. The first branch
is a two-headed cable routed to the two 5.25-inch bays. The second branch is a two-headed
cable routed to the two 3.5-inch hard drive bays.

e  HP has provided extra drive mounting screws (four silver 6-32 mounting screws and three black
M3 mounting screws) installed on the front of the chassis behind the bezel. The 6-32 mounting
screws are required for 3.5-inch hard drives installed in the 3.5-inch hard drive bays and for a
USB 3.0 media card reader installed in the 3.5-inch optional drive bay. M3 metric mounting
screws are required for 5.25-inch optical drives. If you are replacing a drive, remove the mounting
screws from the old drive and install them in the new drive.

Model 480 and model 490:

e  The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATAO.

e  Connect secondary hard drives and optical drives to any of the light blue SATA connectors on the
system board (labeled SATA1, SATA4, and SATA5).

e  Connect a media card reader USB 3.0 cable to the black USB 3.0 connector on the system board
labeled MEDIA 3.0.

e The power cable for the drives has two branches coming out of the power supply. The first branch
is a two-headed cable routed to the two 5.25-inch bays. The second branch is a two-headed
cable routed to the two 3.5-inch hard drive bays.

e HP has provided extra drive mounting screws (four silver 6-32 mounting screws and three black
M3 mounting screws) installed on the front of the chassis behind the bezel. The 6-32 mounting
screws are required for 3.5-inch hard drives installed in the 3.5-inch hard drive bays and for a
USB 3.0 media card reader installed in the 3.5-inch optional drive bay. M3 metric mounting
screws are required for 5.25-inch optical drives. If you are replacing a drive, remove the mounting
screws from the old drive and install them in the new drive.
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No. Mounting Screw Device

1 Silver Standard 6-32 Mounting Screws USB 3.0 Media Card Reader

3.5-inch Hard Drive

2 Black M3 Mounting Screws 5.25-inch Optical Drive

/A CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”
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Drive positions

1 5.25-inch half-height drive bay (optical drive shown)

2 5.25-inch half-height drive bay

3 3.5-inch drive bay for optional drive (media card reader shown)

4 Primary 3.5-inch infernal hard drive bay

5 Secondary 3.5-inch internal hard drive bay

NOTE: The drive configuration on your computer may be different than the drive configuration shown above.

To verify the type and size of the storage devices installed in the computer, run Computer Setup.
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Removing a 5.25-inch drive

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

1.

2
3.
4

Prepare the computer for disassembly (Preparation for disassembly on page 42)

Remove the access panel (Access panel on page 43)

Remove the front bezel (Front bezel on page 44)

Disconnect the power cable and data cable from the back of the drive.

/\ CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to

5.

avoid damaging the cable.

Remove the two black M3 mounting screws from the side of the drive (1) and slide the drive out of
the front of the drive bay (2).

Installing a 5.25-inch drive

E’%NOTE: HP does not offer a 5.25-inch optical drive for this computer model. A 5.25-inch optical drive
can be purchased through a third-party vendor.

1.
2.
3.

Prepare the computer for disassembly (Preparation for disassembly on page 42)

Remove the access panel (Access panel on page 43)

Remove the front bezel (Front bezel on page 44). If you are installing a drive in a bay covered by
a bezel blank, remove the bezel blank. See Bezel blanks on page 45 for more information.
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4. If you are installing an optical drive, install one black M3 metric mounting screw in the front upper
screw hole on the right side of the drive.

r__":"/rNOTE: HP has supplied three extra M3 mounting screws on the front of the chassis behind the
bezel. Refer to Drives on page 59 for an illustration of the extra mounting screws location. When
replacing an optical drive, transfer the M3 mounting screw from the old drive to the new one.

/\ CAUTION: Use only 5-mm long screws as mounting screws. Longer screws can damage the
internal components of the drive.

5. Slide the drive into the drive bay (1) and install the two M3 mounting screws in the side of the
drive (2) to secure it in place.
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6. Connect the power cable (1) and data cable (2) to the back of the hard drive.

2»NOTE: The power cable for the hard drives is a two-headed cable that is routed from the power
supply to the rear of the hard drive bays.

~ o

%/’o

7. Connect the opposite end of the data cable to one of the white (model 400) or light blue (model
490) SATA connectors on the system board.

@NOTE: Refer to System board connections — model 400 on page 56 or System board
connections — model 480 on page 57 for an illustration of the system board drive connectors.

Removing a 3.5-inch device

/\ CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 42)

2. Remove the access panel (Access panel on page 43)

3. Remove the front bezel (Front bezel on page 44)
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4. Disconnect the drive cables from the rear of the drive, or, if you are removing a media card
reader, disconnect the USB cable from the system board as indicated in the following illustration.

o

5. Remove the two silver 6-32 mounting screws from the side of the device (1) and slide the device
out of the front of the drive bay (2).
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Installing a 3.5-inch device (model 400)

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43).

3. Remove the front bezel (Front bezel on page 44). Remove the front bezel. If you are installing a
drive in a bay covered by a bezel blank, remove the bezel blank.

4. Slide the device into the drive bay (1) and install the two 6-32 mounting screws in the side of the
device (2) to secure it in place.

2% NOTE: HP has supplied extra 6-32 mounting screws on the front of the chassis behind the bezel.

Refer to Drives on page 59 for an illustration of the extra mounting screws location.

When replacing a device, use the two 6-32 mounting screws that were removed from the old
device to install the new one.
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5. |Ifinstalling a USB 3.0 media card reader, connect the media card reader 3.0 cable to the USB
3.0 to USB 2.0 adapter (1) and connect the adapter to the connector on the system board labeled

MEDIA (2).
*’ a
|

Jolo

E"%NOTE: Refer to System board connections — model 400 on page 56 or System board
connections — model 480 on page 57 for an illustration of the system board drive connectors.
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Installing a 3.5-inch device (model 480 and model 490)

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43).

3. Remove the front bezel (Front bezel on page 44). Remove the front bezel. If you are installing a
drive in a bay covered by a bezel blank, remove the bezel blank.

4. Slide the device into the drive bay (1) and install the two 6-32 mounting screws in the side of the
device (2) to secure it in place.

2% NOTE: HP has supplied four 6-32 mounting screws on the front of the chassis behind the bezel.
Refer to Drives on page 59 for an illustration of the extra mounting screws location.

When replacing a device, use the two 6-32 mounting screws that were removed from the old
device to install the new one.
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5. |Ifinstalling a USB 3.0 media card reader, connect the media card reader cable to the USB 3.0
connector on the system board labeled MEDIA 3.0.

oY

E/?NOTE: Refer to System board connections — model 400 on page 56 or System board
connections — model 480 on page 57 for an illustration of the system board drive connectors.

Removing a 3.5-inch hard drive

@NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

1. Prepare the computer for disassembly (Preparation for disassembly on page 42)

Remove the access panel (Access panel on page 43)

2
3. Disconnect the power cable and data cable from the back of the hard drive.
4

Remove the four 6-32 mounting screws (1) and slide the drive out of the bay (2).

L 3
-
3
-
§
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Installing a 3.5-inch drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 42)

2. Remove the access panel (Access panel on page 43)

3. You can install a 3.5-inch hard drive or a 2.5-inch hard drive with a 3.5-inch adapter bracket
similar to the example shown below.

e Slide the drive into the bay adapter bracket, ensuring the connector on the drive is fully
inserted into the connector on the adapter bracket.

e  Secure the drive to the bay adapter bracket by installing four black M3 adapter bracket
screws through the sides of the bracket into the drive.

Drives

71



4. Slide the drive into the drive bay (1) and install the four 6-32 mounting screws (2) to secure the
drive in place.

r__":"/%"NOTE: HP has supplied four extra 6-32 mounting screws on the front of the chassis behind the
bezel. Refer to Drives on page 59 for an illustration of the extra mounting screws location. When
replacing a hard drive, use the four 6-32 mounting screws that were removed from the old drive to
install the new one.
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5. Connect the power cable (1) and data cable (2) to the back of the hard drive.

2»NOTE: The power cable for the hard drives is a two-headed cable that is routed from the power
supply to the rear of the hard drive bays.

< %

r,’o

6. Ifinstalling a new drive, connect the opposite end of the data cable to the appropriate system
board connector.

@NOTE: You must connect the primary hard drive data cable to the dark blue connector labeled
SATAO to avoid any hard drive performance problems. If you are adding a second hard drive,
connect the data cable to the light blue SATA connector labeled SATAT model 400) or one of the
light blue SATA connectors (model 490).
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DisplayPort connector module (480 MT and 490 MT
models only)

Description Spare part number

DisplayPort connector module (for use only in 490 MT models) 735966-001

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

Remove the access panel (Access panel on page 43).

Remove the front bezel (Front bezel on page 44).

Ll S

From the outside, rear of the computer, remove the Torx T15 screw that secures the DisplayPort
module to the computer.

74 Chapter 5 Removal and replacement procedures: Microtower



5. From the inside of the computer, pull the module straight up to disengage it from the system board
connector.

To reinstall the DisplayPort connector module, reverse the removal procedure.
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Front 1/0 assembly

Description Spare part number
Front /O assembly 745049-001
1. Prepare the computer for disassembly (Preparation for disassembly on page 42).
2. Remove the access panel (Access panel on page 43).
3. Remove the front bezel (Front bezel on page 44).
4. From the inside of the computer, disconnect the three front |/O cables from the following system
board connectors:
e FRONTUSB 3.0 (P24)
e  FRONT USB (P23)
e FRONT AUD (P23)
5. Remove the cables from the plastic tie on the base pan.
6. From the front of the computer, remove the Torx T15 screw that secures the assembly to the chassis
(1).
7. Rotate the left side of the assembly outward (2).
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8. Pull the assembly away from the computer while threading the wires through the hole in the front
of the chassis (3).

To reinstall the assembly, reverse the removal procedure.
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Power switch/LED assembly

Description Spare part number

Power switch/LED assembly 745050001

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43).

3. Remove the front bezel (Front bezel on page 44).

4. Disconnect the cable from the system board connector labeled PB/LED.

r__f/rNOTE: System board appearance may vary.

5. Press down on the top of the assembly to disengage the tab (1) that secures the assembly to the
chassis.
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6. Rotate the assembly downward to remove it from the chassis (2).

7. Pull the assembly away from the chassis while threading the cable through the hole in front of the
chassis.
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Fan sink
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Description Spare part number
Fan sink for use in 400 and 490 models, standard 745054-001
Fan sink for use in 490 models, BFR/PVC free 748826-001

/\ WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components fo cool before touching.

E/?’NOTE: System board appearance may vary.

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43).

3. Disconnect the fan cable from the system board connector labeled CPUFAN (1), and then loosen
the four silver captive Torx T15 screws that secure the heat sink to the system board.

/\ CAUTION: Remove fan sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. The pins on the socket are very fragile and any damage to
them may require replacing the system board.
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4. Lift the fan sink from atop the processor.

/\ CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to
evenly seat the heat sink on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.
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Processor
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Description

Spare part number

Intel Core i7 processor

4771 (3.5-GHz, 8-MB L3 cache), 84W 742563001
4770 (3.4-GHz, 8-MB L3 cache), 84W 727373001
4770s (3.1-GHz, 8-MB L3 cache), 65W 732507001
Intel Core i5 processors

4670 (3.4-GHz, 6-MB L3 cache), 84W 727381001
4670s (3.1-GHz, 6-MB L3 cache), 65W 732506001
4570 (3.2-GHz, 6-MB L3 cache), 84W 727380001
4570s (2.9-GHz, 6-MB L3 cache), 65W 732505001
4430 (3.0-GHz, 6-MB L3 cache), 84W 745033001
4430s (2.7-GHz, 6-MB L3 cache), 65W 745034-001
Intel Core i3 processors

4340 (3.6-GHz, 4-MB L3 cache), 54W 742562-001
4330 (3.5-GHz, 4-MB L3 cache), 54W 742561001
4130 (3.4-GHz, 4-MB L3 cache), 54W 742560-001
Intel Pentium processors

G3430 (3.3-GHz, 3-MB L3 cache), 54W 742566-001
G3420 (3.2-GHz, 3-MB L3 cache), 54W 742565001
G3220 (3.0-GHz, 3-MB L3 cache), 54W 742564001
G1830 (2.7-GHz, 2-MB L3 cache), 54W 758757-001
G1820 (2.8-GHz, 2-MB L3 cache), 54W 758756001

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

Remove the access panel (Access panel on page 43).

Remove the fan sink (Fan sink on page 80).

aua & O DN
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6. Carefully lift the processor from the socket (3).

/A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

2 NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can be
found on the Web at: http://www8.hp.com/us/en/support-drivers.html.
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Speaker

Description Spare part number

Speaker 745053-001

%%NOTE: System board appearance may vary.

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

Remove the access panel (Access panel on page 43).

Disconnect the speaker cable from the system board connector labeled SPKR.

BowoN

Remove the speaker cable from the cable tie on the base pan.
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5. From the outside front of the chassis, remove the Torx T15 screw that secures the speaker to the
front of the chassis.

6. From the inside of the chassis, slide the speaker toward the right to remove it from its holder, and
then remove it from the chassis.

To replace the speaker, reverse the removal procedures.

Speaker
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Fan

Description Spare part number
Fan 745052-001
Fan, BFR/PVC free 748825-001

@NOTE: System board appearance may vary.

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43).

3. From the outside, rear side of the chassis, remove the two Torx T15 screws that secure the fan to
the chassis.

4. From the inside of the chassis, disconnect the fan control cable (1) from the system board
connector labeled CHFAN2.

5. Lift the fan out of the chassis (2).

To install the fan, reverse the removal procedure. Be sure to orient the air flow out of the computer.
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Power supply

E%?NOTE: System board appearance may vary.

Description Spare part number
Power supply, 300W, Energy Star 5.0 712298-001
Power supply, 300W, Energy Star 6.0 748824-001
Power supply, 300W, Active PFC 715184001
Power supply, 300W, active PFC, SEPA 752628-001
Power supply, 300W, regular 715185-001

E’/{’NOTE: System board appearance may vary.

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43).

3. Disconnect the power cables from the following system board connectors:.

e PWR

e PWRCPU

4. Disconnect the power cables from the rear of the drives.
Power supply connectors connect to the drives as follows:
e  P3 connector: primary hard drive

e P5 connector: primary optical drive

Power supply
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e P4 connector: secondary hard drive

e  Pé connector: secondary optical drive

5. From the outside rear of the chassis, remove the four silver Torx T15 screws that connect the power
supply to the chassis.
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6. From the inside of the chassis, slide the power supply toward the front of the computer, rotate
slightly into the computer so the power supply clears the lip on the top of the chassis, and then lift
the power supply out of the chassis.

To install the power supply, reverse the removal procedure.
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System board
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@NOTE: All system board spare part kits include replacement thermal material.

Description

Spare part number

For use in 400 models:

System board for use in models without Windows 8 718413-001
System board for use in models with Windows 8 Standard 718413501
System board for use in models with Windows 8 Professional 718413-601
System board for use in models with NetClone (the People’s Republic of China only) 745238-001
For use in 490 models:

System board for use in models without Windows 8 718412001
System board for use in models with Windows 8 Standard 718412-501
System board for use in models with Windows 8 Professional 718412-601
System board for use in models with NetClone (the People’s Republic of China only) 745240-001
For use in 480 G1 models:

System board for use in models without Windows 8 747910-001
System board for use in models with Windows 8 Standard 747910-501
System board for use in models with Windows 8 Professional 747910-601
System board for use in models with NetClone (the People’s Republic of China only) 759333001

1. Prepare the computer for disassembly (Preparation for disassembly on page 42).

2. Remove the access panel (Access panel on page 43).

3.  When replacing the system board, make sure the following components are removed from the

defective system board and installed on the replacement system board:

e Memory modules (Memory on page 47)

e  Expansion cards (Expansion cards on page 51)

Fan sink (Fan sink on page 80).

e  Processor (Processor on page 82)

4. Disconnect all cables connected to the system board, noting their location for reinstallation.

5. Remove the eight Torx T15 screws that secure the system board to the chassis.
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6. Slide the system board toward the front of the computer to disengage the I/O panel, and then lift
the back (1/O side) of the board up at angle, and then lift system board out of the computer.

%NOTE: System board appearance may vary.

When reinstalling the system board, first insert the 1/O panel back into the slots in the rear of the
chassis, and then align the board with the chassis screw holes.

E”/?‘NOTE: When replacing the system board, you must change the chassis serial number in the BIOS.
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6 Removal and replacement
procedures: Small Form Factor

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility o verify
that all components operate properly.

@NOTE: Not all features listed in this guide are available on all computers.

Preparation for disassembly

See Routine care, SATA drive guidelines, and disassembly preparation on page 33 for initial safety
procedures.

1. Remove/disengage any security devices that prohibit opening the computer.
2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

/\ CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

5. If the computer is on a stand, remove the computer from the stand and lay the computer down.

2»NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.
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Access panel

Description Spare part number

Access panel 745042-001

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Loosen the thumbscrew on the rear of the computer (1) then slide the panel back (2) and lift if off
the computer (3).

To install the access panel, reverse the removal procedure.

Access panel
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Front bezel

Description Spare part number

Front bezel 745039-001

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 93).

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

To install the front bezel, reverse the removal procedure.
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Front bezel security

The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 923).

3. Remove one of the five silver 6-32 standard screws located on top of the drive cage.

4. Install the security screw through the middle front bezel release tab to secure the front bezel in
place.

Front bezel security
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Bezel blanks

Description Spare part number

Optical drive bezel blank 732769001

On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:

1. Remove the access panel (Access panel on page 93).

2. Remove the front bezel (Front bezel on page 94).

3. To remove a slim optical drive bezel blank, press inward on the five retaining tabs (1) and pull the

blank off the front bezel (2).

To remove a 3.5-inch bezel blank, press the two retaining tabs that hold the bezel blank in place
towards the outer right edge of the bezel (3) and slide the bezel blank back and to the right to
remove it (4).

2»NOTE: After removing the slim optical drive bezel blank and installing a slim optical drive, you can
install an optional bezel trim piece (available from HP) that surrounds the front of the slim optical drive.
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Memory

Description Spare part number
8-GB, PC3-12800 689375-001
4-GB, PC3-12800 671613-001
2-GB, PC3-12800 671612-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DIMMs

The memory sockets on the system board can be populated with up to two industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 16-GB of memory configured in a high-
performing dual channel mode.

DDR3-SDRAM DIMMs

For proper system operation, the DDR3-SDRAM DIMMs must be:

e industry-standard 240-pin

e unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant
e 1.35voltor 1.5 volt DDR3/DDR3L-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

e support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)
e  contain the mandatory JEDEC SPD information

In addition, the computer supports:

e  512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies
e singlessided and double-sided DIMMs

e DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

E"%NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM sockets

There are two DIMM sockets on the system board, with one socket per channel. The sockets are labeled
DIMM1 and DIMM3. Socket DIMM1 operates in memory channel B. Socket DIMM3 operates in

memory channel A.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

@NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior
graphics performance.

e The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

e  The system will operate in a higher-performing dual channel mode if the memory capacity of the
DIMM in Channel A is equal to the memory capacity of the DIMM in Channel B.

e The system will operate in flex mode if the memory capacity of the DIMM in Channel A is not
equal to the memory capacity of the DIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. If one channel will have more memory than the
other, the larger amount should be assigned to Channel A.

e Inany mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

/\ CAUTION:  You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 923).

3. Rotate up the internal drive bay housing to access the memory module sockets on the system

board.
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4. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

@NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

For maximum performance, populate the sockets so that the memory capacity is spread as equally
as possible between Channel A and Channel B.

5. Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

6. Repeat steps 4 and 5 to install any additional modules.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Expansion card

Description Spare part number
Nvidia NVS310 PCle x16 graphics card, 512 MB 707252-001
Nvidia NVS315 PCle x16 graphics card, 1 GB 720837-001
AMD Radeon HD8490 DP PCle x16 graphics card, 1 GB 717219001
AMD Radeon HD8350 DH PCle x16 graphics card, 1 GB DDR3 717220001
Intel Dual Band Wireless-N 7260 802.11 a/b/g/n (2x2) Wireless NIC 745668-001
Intel PRO/1000 single port GbE NIC, includes bracket 728562-001

The computer has three PCl Express x1 expansion slots and one PCl Express x16 expansion slot.

[ NOTE: The PCI Express slots support only low profile cards.
You can install a PCl Express x1, x4, x8, or x16 expansion card in the PCI Express x16 slot.

For dual graphics card configurations, the first (primary) card must be installed in the PCl Express x16
slot.

To remove, replace, or add an expansion card:

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 923).

3. Llocate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.

4. Release the slot cover retention latch that secures the slot covers by lifting the green tab on the
latch and rotating the latch to the open position.
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5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

2% NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate expansion
slot cover on the back of the chassis. Pull the slot cover straight up then away from the inside
of the chassis.

b. If you are removing a PCl Express x1 card, hold the card at each end, and carefully rock it
back and forth until the connectors pull free from the socket. Pull the expansion card straight
up from the socket (1) then away from the inside of the chassis to release it from the chassis
frame (2). Be sure not to scrape the card against the other components.
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c. If you are removing a PCl Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Pull the expansion card straight up from the socket then
away from the inside of the chassis to release it from the chassis frame. Be sure not to scrape

the card against the other components.

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

/\ CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.
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8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis (1) so that the bracket on the card is
aligned with the open slot on the rear of the chassis. Press the card straight down into the
expansion socket on the system board (2).

2 NOTE: When installing an expansion card, press firmly on the card so that the whole connector
seats properly in the expansion card slot.

9. Rotate the slot cover retention latch back in place to secure the expansion card.

10. Connect external cables to the installed card, if needed. Connect internal cables to the system

board, if needed.

11. Reconfigure the computer, if necessary.
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System board connections

Refer to the following illustration and table to identify the system board connectors for your model.

99

No. System Board Connector System Board Label Color Component

1 PCl Express x1 X1PCIEXP3 black Expansion Card

2 PCl Express x1 X1PCIEXP2 black Expansion Card

3 PCI Express x1 X1PCIEXP1 black Expansion Card

4 PCl Express x16 X16PCIEXP black Expansion Card

5 Parallel Port PAR black Optional Parallel Port

6 Serial Port COMB black Optional Second Serial Port
7 Battery BAT black Memory Module

8 DIMM3 (Channel A) DIMM3 black Memory Module

9 DIMM1 (Channel B) DIMM1 black Memory Module

10 SATA 3.0 SATAO dark blue Primary Hard Drive

11 SATA 3.0 SATAI light blue Secondary Hard Drive

12 SATA 2.0 SATAS white Optical Drive

13 USB 2.0 MEDIA black USB 2.0 Device, such as a Media

Card Reader
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Drives

Description Spare part number

Optical drives

DVD+RW drive 657958-001
DVD-ROM drive 608394-001
Blu-ray BD-RW SuperMulti XL Drive 719157001

Hard drives

2 TB, 7200 rpm hard drive, 3.5 inch 747993-001
1 TB hard drive, hybrid SSD 724937-001
1 1B, 7200 rpm hard drive, 3.5 inch 747992-001
500 GB, 7200 rpm hard drive, 3.5 inch 751283-001
500 GB hard drive, hybrid SSD 724938-001
256 GB Solid State Drive (SSD), self-encrypting (SED) 680020-001
180 GB Solid State Drive (SSD) 754076-001
128 GB Solid State Drive (SSD) 665961-001
120 GB Solid State Drive (SSD) 756459-001
20 GB Solid State Drive (SSD) 683305-001

Card reader

14-in-1, USB 3.0, 3.5-inch, UHS- 716390-001
15-in-1, USB 3.0, 3.5-inch, UHS-I 736299-001
Adapter, USB 3.0 to 2.0 736835-001

When installing drives, follow these guidelines:

e  The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATAO.

e  Connect a secondary hard drive to the light blue SATA connector on the system board labeled
SATAT.

e  Connect an optical drive to the white SATA connector on the system board labeled SATAS.

e Connect a media card reader USB 3.0 cable with a USB 3.0 to USB 2.0 adapter to the USB 2.0
connector on the system board labeled MEDIA.

e The power cable for the drives has two branches coming off the system board connector. The first
branch is a dual-headed cable with the first connector (four-wire) routed to the 3.5-inch optional
drive bay and the second connector (two-wire) routed to the slim optical drive bay. The second
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branch is a dual-headed cable with the first connector routed to the 3.5-inch hard drive bay and
the second connector routed to the 2.5-inch hard drive bay.

e  You must install guide screws to ensure the drive will line up correctly in the drive cage and lock in
place. HP has provided four extra 6-32 standard guide screws installed on the top of the drive
bay. The 6-32 standard guide screws are required for a media card reader or a secondary hard
drive installed in the 3.5-inch optional drive bay. M3 isolation mounting guide screws for 2.5-inch
hard drives are not provided. If you are replacing a drive, remove the guide screws from the old
drive and install them in the new drive.

S S— . e

There are a total of five extra silver 6-32 standard screws. One is used for bezel security (1) (see Front
bezel security on page 95 for more information). The other four are used as guide screws for a media
card reader or a secondary hard drive in the 3.5-inch optional drive bay (2).

/\ CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”
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Drive positions

1 Slim optical drive bay

2 3.5-inch internal hard drive bay

3 3.5-inch drive bay for optional drives (media card reader shown)

4 2.5-inch internal hard drive bay

NOTE: The drive configuration on your computer may be different than the drive
configuration shown above.

To verify the type and size of the storage devices installed in the computer, run Computer Setup.
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Removing a 3.5-inch device

/\ CAUTION:  All removable media should be taken out of a drive before removing the drive from the
computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

Remove the access panel (Access panel on page 923).

2
3. Remove the front bezel (Front bezel on page 94).
4. Rotate the drive cage to its upright position.

5

Disconnect the drive cables from the rear of the drive, or, if you are removing a media card
reader, disconnect the USB cable from the system board as indicated in the following illustration.

108  Chapter 6 Removal and replacement procedures: Small Form Factor



6. Press inward on the release lever at the rear of the device (1) and slide the device out of the rear
of the drive bay (2).

Installing a 3.5-inch device

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 923).

3. Remove the front bezel (Front bezel on page 94). If you are installing a drive in a bay covered by
a bezel blank, remove the bezel blank. See Bezel blanks on page 96 for more information.

4. Install 6-32 guide screws in the holes on each side of the device.

2»NOTE: HP has supplied four extra 6-32 guide screws on top of the drive cage. Refer to Drives
on page 105 for an illustration of the extra guide screws location.

When replacing a device, transfer the four 6-32 guide screws from the old device to the new one.
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5. Rotate the drive cage fo its upright position.

6. Slide the device into the drive bay, making sure to align the guide screws with the guide slots,
until the device snaps into place.
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7. Ifinstalling a USB 3.0 media card reader, you must use the USB 3.0 to USB 2.0 adapter and
connect the adapter cable from the media card reader to the USB 2.0 connector on the system

board labeled MEDIA.
*, J

Jolo

@NOTE: Refer to System board connections on page 104 for an illustration of the system board
drive connectors.

8. Rotate the drive cage back down to its normal position.

/\ CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.
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Removing a slim optical drive

/\ CAUTION:  All removable media should be taken out of a drive before removing the drive from the
computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 923).

3. Disconnect the power and data cables (1) from the rear of the optical drive, push the green
release latch on the right rear side of the drive toward the center of the drive (2), then slide the
drive forward and out of the bay through the front bezel (3).

/\ CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to
avoid damaging the cable.
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Installing a slim optical drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

If the computer is on a stand, remove the computer from the stand.

Remove the access panel (Access panel on page 93).

Lol S

Remove the front bezel (Front bezel on page 94) if you are installing a drive in a bay covered by
a bezel blank, then remove the bezel blank. See Bezel blanks on page 926 for more information.

5. Before the new optical drive can be used, the release latch must be attached.
a. Peel the backing off the adhesive on the release latch.

b. Without allowing the release latch to touch the optical drive, carefully align the holes on the
release latch with the pins on the side of the optical drive. Make sure the release latch is
oriented properly.

c. Insert the pin at the front of the optical drive into the hole at the end of the release latch, and
press firmly.

d. Insert the second pin, and press the entire release latch firmly to fasten the latch securely to
the optical drive.
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6. Slide the optical drive through the front bezel all the way into the bay so that it locks in place (1),
then connect the power and data cables to the rear of the drive (2).

12D
sl
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7. Connect the opposite end of the data cable to the white SATA connector on the system board
labeled SATAS.

i -

[ NOTE: Refer to System board connections on page 104 for an illustration of the system board
drive connectors.

8. Replace the front bezel if it was removed.

2 NOTE: An optional bezel trim piece that surrounds the front of the optical drive is available from
HP. Install the bezel trim piece in the front bezel before installing the front bezel.

Removing and replacing a 3.5-inch hard drive

2»NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

If the computer is on a stand, remove the computer from the stand.

Remove the access panel (Access panel on page 93).

Lol S

Disconnect the power cable and data cable from the back of the hard drive.
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5. Pull the release lever next to the rear of the hard drive outward (1). While pulling the release lever
out, slide the drive back until it stops, then lift the drive up and out of the bay (2).

6. To install a hard drive, you must transfer the silver and blue isolation mounting guide screws from
the old hard drive to the new hard drive.

)
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7. Align the guide screws with the slots on the chassis drive cage, press the hard drive down into the
bay, then slide it forward until it stops and locks in place.

8. Connect the power cable and data cable to the back of the hard drive.

E”%NOTE: The data cable for the primary hard drive must be connected to the dark blue connector
labeled SATAO on the system board to avoid any hard drive performance problems.

9. Replace the access panel.
10. If the computer was on a stand, replace the stand.
11. Reconnect the power cord and turn on the computer.

12. Lock any security devices that were disengaged when the access panel was removed.
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Removing a 2.5-inch hard drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

Remove the access panel (Access panel on page 923).

Rotate the drive cage to its upright position.

Disconnect the power cable and data cable from the back of the hard drive.

L

Pull outward on the release lever at the rear of the drive (1) then slide the drive back until it stops
and pull it down and out of the drive bay (2).

Installing a 2.5-inch hard drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. If the computer is on a stand, remove the computer from the stand.

3. Remove the access panel (Access panel on page 93).
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4. Install four black and blue M3 isolation mounting guide screws (two on each side of the drive).

E%?NOTE: M3 metric isolation mounting guide screws can be purchased from HP.

When replacing a drive, transfer the four M3 isolation mounting guide screws from the old drive
to the new one.

5. Rotate the drive cage fo its upright position.

6. Align the guide screws on the drive with the J-slots on the sides of the drive bay. Press the drive up
into the drive bay then slide it forward until it locks in place.

7. Connect the power cable and data cable to the back of the hard drive.

E”%NOTE: If the 2.5-inch hard drive is the primary drive, connect the data cable to the dark blue
SATA connector labeled SATAO on the system board. If it is a secondary drive, connect the data
cable to one of the light blue SATA connectors on the system board.

8. Rotate the drive cage back down to its normal position.

/\ CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.
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Power supply

Description Spare part number
Power supply, 240W, 85% efficient 722536-001
Power supply, 240W, standard 702457-001

/\ WARNING! To reduce potential safety issues, only the power supply provided with the computer, a

replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.

The power supply is located at the rear of the chassis. It is held in place by three Torx screws outside of
the chassis and a release lever inside of the chassis.

/A WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 93).

3. Rotate the drive cage to the upright position.

4. Disconnect all power cables from the following system board connectors:
e PWRCPU
e PWRCMD
e PWR

5. Release the power supply cables from the cable retaining clip under the drive cage.

Power supply 119



6. From the outside, rear of the computer, remove the three Torx screws that secure the power supply
to the rear of the chassis.

7. From the inside of the chassis, press the release button at the front of the power supply (1).

8. Slide the power supply forward (2), and then lift it out of the chassis (3).

e O YR

To install the power supply, reverse the removal procedure.

/\ CAUTION: When installing the power supply cables, make sure they are properly positioned in the
clip under the drive cage.
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Fan duct

Description Spare part number

Fan duct 727145-001

The fan duct sits between the front fan and the heat sink.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 93).

3. Rotate the fan duct upward.

4. Pull the duct away from the chassis to disengage the clips on the duct from the chassis.

To install the fan duct, insert the clips on the edge of the fan onto the metal posts on the chassis.
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Front 1/0 assembly

Description Spare part number

Front /O assembly 745037-001

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

Remove the access panel (Access panel on page 93).

Remove the front bezel (Front bezel on page 94).

Rotate the drive cage fo its upright position.

LA

Cut the plastic tie that secures the longer cable to the power supply.

.

6. Disconnect the cables from the system board as follows:

e  Yellow connector labeled FRONT USB
e Blue connector labeled FRONT USB 3.0
e Blue connector labeled FRONT AUD
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e

RGNT USB

7. Remove the cables from the cable clips under the drive cage.

8. Remove the Torx T15 screw (1) that secures the assembly to the front of the chassis.
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9. Press the tab on the right side of the assembly (2) to disengage it from the chassis.

To install the assembly, insert the assembly from the inside of the chassis, and then pull the tab on the
left side of the assembly out the front of the chassis. Push the right side until it clicks into place.

2% NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly.
Proper cable routing prevents damage to the cables and allows the drive cage to close properly.
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Power switch assembly

Description Spare part number

Power switch assembly 745038-001

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

Remove the access panel (Access panel on page 93).

Remove the front bezel (Front bezel on page 94).

Rotate the drive cage to its upright position.

I S

Disconnect the cable from the system board connector labeled PB/LED.
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6. Remove the cable from the cable clips under the drive cage.

7. From the inside of the chassis, press down on the tab on the top of the power switch to disengage
the power switch from the chassis.
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8. Pull the power switch out the front of the chassis, while routing the cable through the hole in the
chassis.

To install the power switch assembly, first insert the cable through the hole from the front of the chassis.
After inserting the cable, place the bottom of the assembly into the slot, and then rotate the top up until
it snaps into place.

r__":"/?NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly.
Proper cable routing prevents damage to the cables and allows the drive cage to close properly.
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Speaker

Description Spare part number

Speaker 727149-001

The speaker is attached to the front of the chassis under the rotating drive cage.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

. Remove the access panel (Access panel on page 93).

2
3. Remove the front bezel (Front bezel on page 94).
4. Rotate the drive cage to its upright position.

5

. Lift the metal clip (1) that secures the speaker cable, and then disconnect the speaker wire from
the white system board connector labeled SPKR (2).
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6. From the outside, front of the chassis, remove the two Torx screws that secure the speaker to the
chassis.

7. Lift the speaker from the inside of the chassis to remove it.

To install the speaker, reverse the removal procedures.
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Fan sink

Description Spare part number

Fan sink 745661-001

The fan sink is secured atop the processor with four captive Torx screws. The fan sink includes a heat
sink and a fan.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

Remove the access panel (Access panel on page 923).

Remove the fan duct (Fan duct on page 121).

2w N

Loosen the four captive Torx T15 screws that secure the fan sink to the system board tray.

/A CAUTION: Remove fan sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.
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5. Disconnect the fan cable from the system board connector labeled CPUFAN (1), and then lift the
heat sink from atop the processor (2).

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

/\ CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) t

evenly seat the fan sink on the processor to avoid damage that could require replacing the system

board.

Make sure to replace the fan duct. Failure to install the fan duct may cause the computer to overheat.

O

Fan sink
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Processor

Description

Spare part number

Intel Core i7 processors

4771 (3.5-GHz, 8-MB L3 cache), 84W 742563001
4770 (3.4-GHz, 8-MB L3 cache), 84W 727373001
4770s (3.1-GHz, 8-MB L3 cache), 65W 732507001
Intel Core i5 processors

4670 (3.4-GHz, 6-MB L3 cache), 84W 727381001
4670s (3.1-GHz, 6-MB L3 cache), 65W 732506001
4570 (3.2-GHz, 6-MB L3 cache), 84W 727380001
4570s (2.9-GHz, 6-MB L3 cache), 65W 732505001
4430 (3.0-GHz, 6-MB L3 cache), 84W 745033001
4430s (2.7-GHz, 6-MB L3 cache), 65W 745034-001
Intel Core i3 processors

4340 (3.6-GHz, 4-MB L3 cache), 54W 742562-001
4330 (3.5-GHz, 4-MB L3 cache), 54W 742561001
4130 (3.4-GHz, 4-MB L3 cache), 54W 742560-001
Intel Pentium processors

G3430 (3.3-GHz, 3-MB L3 cache), 54W 742566-001
G3420 (3.2-GHz, 3-MB L3 cache), 54W 742565001
G3220 (3.0-GHz, 3-MB L3 cache), 54W 742564001
G1830 (2.8-GHz, 2-MB L3 cache), 54W 758757-001
G1820 (2.7-GHz, 2-MB L3 cache), 54W 758756001

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

Remove the access panel (Access panel on page 923).

Remove the fan duct (Fan duct on page 121).

Remove the fan sink (Fan sink on page 130).

Rotate the locking lever to its full open position (1).

o U b~ W N
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7. Carefully lift the processor from the socket (3).

/A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

2 NOTE:  After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can be
found on the Web at: http://www8.hp.com/us/en/support-drivers.html.
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System board

Description Spare part number
System board for use in models without Windows 8 (includes thermal material) 718414-001
System board for use in models with Windows 8 Standard (includes thermal material) 718414-501
System board for use in models with Windows 8 Professional (includes thermal material) 718414-601
System board for use only in models in the People’s Republic of China with NetClone (includes 745239001

thermal material)

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Remove the access panel (Access panel on page 923).

3.  When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

e Memory modules (Memory on page 97)

e  Expansion cards (Expansion card on page 100)

e  Fan sink (Fan sink on page 130)

e  Processor (Processor on page 132)

Remove the fan duct from the chassis (Fan duct on page 121).

Rotate the drive cage to its upright position.

Disconnect all data and power cables from the system board.

N o u &

Remove the eight Torx screws that secure the system board to the chassis.
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8. Slide the system board toward the front of the chassis to disengage the connectors.

9. Lift the system board up and out of the chassis.

To install the system board, reverse the removal procedure.

r__i?NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

/\ CAUTION: When reconnecting the cables it is important that they be positioned correctly.

System board
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Changing from desktop to tower configuration

The Small Form Factor computer can be used in a tower orientation with an optional tower stand that
can be purchased from HP.

1. Prepare the computer for disassembly (Preparation for disassembly on page 92).

2. Orient the computer so that its right side is facing down and place the computer in the optional
stand.

I

22 NOTE: To stabilize the computer in a fower orientation, HP recommends the use of the optional
tower stand.

3. Reconnect the power cord and any external devices, then turn on the computer.

2 NOTE: Ensure at least 10.2 centimeters (4 inches) of space on all sides of the computer remains
clear and free of obstructions.
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7 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media
devices.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

Q always Quick Boot (default);
Q periodically Full Boot (from every 1 to 30 days); or
Q always Full Boot.

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.

Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

Secure integrated /O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.
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e Enable or disable removable media boot ability.

e  Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

e  Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

o  Execute selftests on a specified ATA hard drive (when supported by drive).

e Enable or disable Drivelock security (when supported by drive).

Using Computer Setup (F10) Utilities
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Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.
2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.

2% NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Utilities
menu, press Esc.

5. To apply and save changes, select File > Save Changes and Exit.

e If you have made changes that you do not want applied, select Ignore Changes and
Exit.

e To reset fo factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

E’%NOTE: Not all seftings shown in the following sections are available for all models

/\ CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup

(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only after
exiting the F10 Setup screen.
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Ly NOTE:

Computer Setup—File

configuration.

Support for specific Computer Setup options may vary depending on the hardware

Table 7-1 Computer Setup—File

Option

Description

System Information

Lists:

e  Product name

e  Manufacturer

e  SKU number

e  Processor type/speed/stepping

e  Cache size (L1/L2/L3) (dual core processors have this listed twice)
e Installed memory size/speed, number of channels (single or dual) (if applicable)
e Integrated MAC address for embedded, enabled NIC (if applicable)
e  Chassis serial number

e  Asset tracking number

e  System Board ID and CT Number

e  System BIOS Version and Date

About

Displays copyright notice.

Set Time and Date

Allows you to set system time and date.

Flash System ROM

Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup

Save to Removable Media
Saves system configuration to a formatted USB flash media device.
Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup

Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default seftings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.

Computer Setup (F10) Utilities
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Computer Setup—Storage
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2¥»NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 7-2 Computer Setup—Storage

Option

Description

Device
Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

e Hard Disk: Size, model, firmware version, serial number, connector color, SMART category.

e  CD-ROM: Model, firmware version, serial number, connector color (not included for USB CD-
ROM).

e  SMART (ATA disks only)
o Diskette: Model and firmware version.

NOTE: Displays for USB diskette drives.

Storage Options

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are three supported options: IDE, RAID, and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

IDE - This is the most backwards-compatible sefting of the three options. Operating systems usually
do not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver
loaded in the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/
AHCI volume. If you attempt to boot from a RAID/AHCI volume without the required device driver
installed, the system will crash (blue screen). RAID volumes may become corrupted if they are
booted to after disabling RAID.
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Table 7-2 Computer Setup—Storage (continued)

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.

Boot Order Allows you to:

e  UEFI Boot Sources: Specify the order in which EFl boot sources (such as a internal hard
drive, USB hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included
for consideration as a bootable operating system source.

EFl boot sources always have precedence over legacy boot sources.

e Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network
interface card, internal hard drive, USB optical drive, or internal optical drive) are checked for
a bootable operating system image. Each device on the list may be individually excluded from
or included for consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device fo a preferred place, press Enter. To remove the device from
consideration as a bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.

NOTE: MS-DOS drive leftering assignments may not apply after a non-MS-DOS operating system
has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (fo access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security
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2¥»NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 7-3 Computer Setup—Security

Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play seftings under Windows.

Power-On
Password

Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle or reboot. If the user does not enter the correct power-on password, the unit will not
boot.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

e  Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to
change resource settings for serial and parallel pors).

e  Stringent security (enabling the stringent password disables the ability to reset the password by
moving the jumper on the system board). Default is disabled.

CAUTION: If you enable the stringent security feature and you forget the setup password or
the power-on password, the computer is inaccessible and can no longer be used.

If you lose or forget the password, the system board must be replaced. This scenario is not
covered under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup
password or power-on password in a safe place away from your computer. Without these
passwords, the computer cannot be unlocked.

e  Setup Browse Mode (appears if a setup password is sef) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

e  Password prompt on F9 & F12 (requires setup password to use these boot functions). Default is
enabled.

e  Network Server Mode. Default is disabled.

Smart Cover

Only displays if the computer is equipped with a smart cover.

Allows you to:

e Lock/unlock the Cover Lock.

e  Setthe Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been removed.
Setup Password requires that the setup password be entered to boot the computer if the sensor
detects that the cover has been removed.

Chapter 7 Computer Setup (F10) Utility



Table 7-3 Computer Setup—Security (continued)

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:
e  Embedded security device
e  System audio
e  USB controller (varies by model)
e  Network controller
NOTE: You must disable AMT before trying to hide the network controller.
e  Serial port
o  Parallel port

e  SATA poris (varies by model)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:
e  Front USB Poris
e  Rear USB Ports

e  Accessory USB Ports

Slot Security Allows you to disable any PCl or PCl Express slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCl
expansion card or embedded on the system board.) Default is enabled.

System IDs Allows you to set:

e  Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

e  Ownership tag (80-byte identifier) displayed during POST.

e  Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are used
to uniquely identify the system.)

e  Keyboard locale setting for System ID entry.
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Table 7-3 Computer Setup—Security (continued)

Master Boot Record
Security

Enables/disables Master Boot Record (MBR) security.

The MBR contains information needed to successfully boot from a disk and to access the data stored
on the disk. Master Boot Record Security may prevent unintentional or malicious changes to the
MBR, such as those caused by some viruses or by the incorrect use of certain disk utilities. It also
allows you to recover the "last known good" MBR, should changes to the MBR be detected when
the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS
cannot prevent changes that may occur while the operating system is running.

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.
Only appears if all of the following conditions are true:

e  MBR security is enabled

e A backup copy of the MBR has been previously saved

e  The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified
the MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved
MBR if you are confident that the current bootable disk's MBR has been corrupted or infected with a
virus.
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Table 7-3 Computer Setup—Security (continued)

System Security
(these options are
hardware dependent)

NOTE: Available options are displayed depending on system configuration.

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.

SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.

Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the
processor. Changing this sefting requires turning the computer off and then back on. Default is

disabled.

Virtualization Technology Directed I/O (VTd) (enable/disable) - Controls virtualization DMA
remapping features of the chipset. Changing this setting requires turning the computer off and then
back on. Default is disabled.

Trusted Execution Technology (enable/disable) - Controls the underlying processor and chipset
features needed to support a virtual appliance. Changing this setting requires turning the computer
off and then back on. Default is disabled. To enable this feature you must enable the following
features:

e  Embedded Security Device Support
e  Virtualization Technology
e  Virtualization Technology Directed I/O

Embedded Security Device (enable/disable) - Permits activation and deactivation of the Embedded
Security Device.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

e  Reset fo Factory Settings (Do not reset/Reset) - Resetting to factory defaults will erase all
security keys and leave the device in a disabled state. Changing this setting requires that you
restart the computer. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security schemes.

Erasing the security keys will prevent access to data protected by the Embedded Security
Device. Choosing Reset to Factory Settings may result in significant data loss.

e  Measure boot variables/devices to PCR1 - Typically, the computer measures the boot path and

saves collected metrics to PCR5 (a register in the Embedded Security Device). Bitlocker tracks
changes to any of these metrics, and forces the user to re-authenticate if it detects any
changes. Enabling this feature lets you set Bitlocker to ignore detected changes to boot path
metrics, thereby avoiding re-authentication issues associated with USB keys inserted in a port.
Default is enabled.
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Table 7-3 Computer Setup—Security (continued)

System Security OS management of Embedded Security Device (enable/disable) - This option allows the user to limit
(continued) OS control of the Embedded Security Device. Default is enabled. This option is automatically
disabled if Trusted Execution Technology is enabled.

e  Reset of Embedded Security Device through OS (enable/disable) - This option allows the user
to limit the operating system ability to request a Reset to Factory Settings of the Embedded
Security Device. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

e No PPI provisioning (Windows 8 only) - This option lets you set Windows 8 to bypass the PPI
(Physical Presence Interface) requirement and directly enable and take ownership of the TPM
on first boot. You cannot change this setting after TPM is owned/initialized, unless the TPM is
reset. Default is disabled for non-Windows 8 systems, and enabled for Windows 8.

e  Allow PPl policy to be changed by OS. Enabling this option allows the operating system to
execute TPM operations without Physical Presence Interface. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

Drivelock Security  Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the Drivelock passwords during POST. If neither is
successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the Drivelock feature
is aftached to the system.

Secure Boot e Llegacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,

Configuration including booting to DOS, running legacy graphics cards, booting to legacy devices, and so
on. If set fo disable, legacy boot options in Storage > Boot Order are not displayed.
Default is enabled.

e  Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate
before booting to it, making Windows resistant to malicious modification from preboot to full
OS booting, preventing firmware attacks. UEFI and Windows Secure Boot only allow code
signed by pre-approved digital certificates to run during the firmware and OS boot process.
Default is disabled, except for Windows 8 systems which have this setting enabled. Secure
Boot enabled also sets Legacy Support to disabled.

e Key Management—This option lets you manage the custom key settings.

o Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded
custom boot keys. Default is Don't Clear.

o Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify
the contents of the secure boot signature databases and the platform key (PK) that verifies
kernels during system start up, allowing you fo use alternative operating systems.
Selecting HP Keys causes the computer boot using the preloaded HP-specific boot keys.
Default is HP Keys.

e  Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f
keys to access items before the operating system loads. Default is disabled.

NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically
and display advanced boot options.

From Windows 8, you can press Shift and select Restart to access the screen that lets you
boot to a device or troubleshoot your computer.
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Computer Setup—Power

E%?NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 7-4 Computer Setup—Power

Option Description
OS Power e Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
Management processors power consumption when the processor is idle. Default is extended.

e  Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

e  Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern.
Default is disabled.

NOTE: For Windows 8 systems with Fast Boot support, a normal shutdown goes to the S4
state, not the S5 state.

- S0 (On) = Solid white LED.

oS3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(white LED) — repeated cycles of 3 blinks and a pause.

oS4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(white LED) — repeated cycles of 4 blinks and a pause.

o S5 (Soft Off) = LED is off.

Hardware Power SATA Power Management — Enables or disables SATA bus and/or device power management.
Management Default is enabled.

S5 Maximum Power Savings — Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

PCl Express Power Management — Sets Active State Power Management (ASPM) of the bus. ASPM
lets you set lower power modes that activate when the bus is not being used. Options are Disabled,
LOs, L1, LOs and L1. Default is ASPM Disabled.

Network Controller — Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

USB 3.0 Controller — Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced
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2¥»NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 7-5 Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options  Allows you fo set:

POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

o QuickBoot (default) = Do not clear memory or perform a memory test.

o FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

o Clear Memory = No memory count on cold boot. Clears memory on all boots.

o FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

POST messages (enable/disable). Enabling this feature will cause the system to display POST
error messages, which are error messages displayed on the monitor during the Power On Self
Test if the BIOS encounters some kind of problem while starting the PC. A POST error message
will only display on screen if the computer is capable of booting this far. If the POST defects
an error before this point, a beep code is generated instead. Default is disabled.

Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of the
text “Press the ESC key for Startup Menu” during POST. This text does not display on
Windows 8 systems with Fast Boot support. Other text also will not display (for example,
Ownership Tag). Default is enabled.

Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. Default is enabled.

After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
o Power off—causes the computer to remain powered off when power is restored.
o Power on—causes the computer to power on automatically as soon as power is restored.

° Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able fo use the suspend/sleep feature or the Remote Management features.

POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCl cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST delay
also gives you more time to select F10 to enter Computer (F10) Setup. Default is None.

Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect
the boot to the recovery partition on the user hard drive, if present. Some versions of the
recovery software honor the F11 key press even when this feature is disabled by the BIOS.
Default is disabled.

Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the computer
not to confirm when changes were made. Default is disabled.
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Table 7-5 Computer Setup—Advanced (for advanced users) (continued)

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.

Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all
operating systems. To hide a device from the operating system, see Security > Device Security.

Bus Options Allows you to enable or disable:
e  PCI SERR# Generation. Default is enabled.

e  PCl VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

e  Printer mode (Bi-Directional, EPP + ECP, Output Only). ECP = Enhanced Capabilities Port, EPP
= Enhanced Parallel Port. Default is EPP+ECP.

e Num Lock State at Power-On (off/on). Default is off.

e Integrated Video (enable/disable). Use this option to disable the integrated video controller
when another video controller is present in the system. Default is enabled.

e Integrated Graphics (Auto/Disable/Force) Use this option to manage integrated (UMA)
graphics memory allocation. The value you choose is allocated permanently to graphics and is
unavailable to the operating system. For example, if you set this value o 512M on a system
with 2 GB of RAM, the system always allocates 512 MB for graphics and the other 1.5 GB for
use by the BIOS and operating system. Default is Auto which sets memory allocation to 512
MB.

If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA
memory size allocation between 32 MB and 1 GB.

e Internal Speaker (does not affect external speakers). Default is enabled.

e  NIC PXE Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded
NIC option ROM to allow the unit to boot through the network to a PXE server. This is typically
used to download a corporate image to a hard drive. The NIC option ROM takes up memory
space below TMB commonly referred to as DOS Compatibility Hole (DCH) space. This space
is limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCl cards which may need option
ROM space. The default will be to have the NIC option-ROM-enabled. Default is PXE.

e  SATA RAID Option ROM Download (enable/disable). The BIOS contains an embedded SATA
RAID option ROM for RAID support. This can be temporarily disabled to save DCH space.
Note that with the option ROM disabled, users will be unable to boot to hard drives in the
system while running in RAID mode. Default is disabled.

e  Multi-Processor (enable/disable). Use this option to disable multi-processor support under the
OS. Default is enabled.

e  Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

e  Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature,
which allows one core of the system fo run at a higher than standard frequency and power if
other cores are idle. Default is enabled.

VGA Configuration  Displayed only if there is an add-in video card in the system. Allows you to specify which VGA
controller will be the “boot” or primary VGA controller.
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Table 7-5 Computer Setup—Advanced (for advanced users) (continued)

Option ROM Launch Let you set the launch policy for option ROMs. An Option ROM typically consists of firmware that is
Policy called by the system BIOS. For example, an adapter card that controls a boot device might contain
firmware that is used to connect the device to the system once the Option ROM is loaded.

e  PXE Option ROMs (legacy only/EFI only/do not launch)
e  Storage Option ROMs (legacy only/EFI only/do not launch)
e  Video Option ROMs (legacy only/EFl only)

e  NetClone Option ROMs (legacy only/do not launch)

AMT Configuration  Allows you to set:

e  AMT (enable/disable). Allows you to enable or disable functions of the embedded
Management Engine (ME) such as Active Management Technology (AMT). If set to disable, the
Management Engine is set to a temporarily disabled state and will not provide functions
beyond necessary system configuration. Default is enabled.

e  Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned
management settings for AMT. The AMT settings are restored to factory defaults. This feature
should be used with caution as AMT will not be able to provide any set AMT management
functions once unconfigured. Default is disabled.

e  Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to
not display the confirmation to unconfigure ME.

e  Waichdog Timer (enable/disable). Allows you to set amount of time for a operating system
and BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is
deactivated by BIOS and would indicate that a halt occurred during execution if the alert is
sent fo the management console. An operating system alert is deactivated by the operating
system image and would indicate that a hang occurred during its initialization. Default is
enabled.

Recovering the Configuration Settings
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This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File
on page 139 in the Computer Setup—File table.)

@NOTE: It is recommended that you save any modified computer configuration settings to a USB flash
media device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility.
(See Computer Setup—File on page 139 in the Computer Setup—File table.)
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8 Troubleshooting without
diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices,
hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems
with the computer, refer to the tables in this chapter for probable causes and recommended solutions.

2 NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST error messages on page 190.

Safety and comfort

/\ WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before you call for technical support

It you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

Run the HP diagnostic tool.

Run the hard drive selftest in Computer Setup. Refer to Computer Setup (F10) Utility on page 137
for more information.

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST error messages
on page 190 for more information.

If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

If you recently added new hardware, remove the hardware and see if the computer functions
properly.
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If you recently installed new software, uninstall the software and see if the computer functions
properly.

Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

Refer to the comprehensive online technical support at http://www.hp.com/support.

Refer to Helpful hints on page 152 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's
online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

Be in front of your computer when you call.

Write down the computer serial number, product ID number, and monitor serial number before
calling.

Spend time troubleshooting the problem with the service technician.
Remove any hardware that was recently added to your system.
Remove any software that was recently installed.

Restore the system from the Recovery Disc Set that you created or restore the system fo its original
factory condition in System Software Requirement Disks (SSRD).

/\ CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

E/?’NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dedaler.

Helpful hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:
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Check that the computer and monitor are plugged into a working electrical outlet.

Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

Check that the computer is turned on and the white power light is on.

Check that the monitor is turned on and the green monitor light is on.
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e  Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST error messages
on page 190 for more information.

e  Turn up the brightness and contrast controls of the monitor if the monitor is dim.
e Press and hold any key. If the system beeps, then the keyboard should be operating correctly.
o  Check all cable connections for loose connections or incorrect connections.

e  Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set fo power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

e  Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 174 for instructions.

e  Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

e Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on the system.

e If the system has multiple video sources (embedded, PCl, or PCl-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the other
monitor connectors are disabled and if the monitor is connected into these ports, the monitor will
not function. You can select which source will be the default VGA source in Computer Setup.

/\ CAUTION: When the computer is plugged into an AC power source, there is always voltage
applied to the system board. You must disconnect the power cord from the power source before
opening the computer to prevent system board or component damage.
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Solving general problems

You may be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,

contact an authorized dealer or reseller.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to

the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet and allow the internal system components to cool

before touching.

Computer appears locked up and will not turn off when the power button is pressed.

Cause

Solution

Software control of the power switch is not functional.

1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause

Solution

Computer is in Sleep state.

To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

System has locked up.

Restart computer.

Computer date and time display is incorrect.

Cause

Solution

RTC (realtime clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

Reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Removal and Replacement section for instructions on installing
a new battery, or contact an authorized dealer or reseller for
RTC battery replacement.

To access Control Panel in Windows 7, select Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start screen,
type c, and then select Control Panel from the list of
applications.
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Cursor will not move using the arrow keys on the keypad.

Cause

Solution

The Num Lock key is turned on.

Press the Num Lock key. The Num Lock light must be off if you
want to use the arrow keys on the keypad. You can also
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

There is no sound or sound volume is too low.

Cause

Solution

System volume may be set low or muted.

1. Check the Computer Setup settings to make sure the
internal system speaker is not muted (this sefting does not
affect the external speakers).

2. Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is
set correctly.

3. Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or access panel.

Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock .
A key to unlock the Smart Cover Lock is not available from
HP. Keys are typically available from a hardware store.

Poor performance.

Cause

Solution

Processor is too hot.

1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the

hard drive.

Low on memory.

Add more memory.
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Poor performance.

Cause

Solution

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

Windows 7:

1.

2.

Close unnecessary applications to free up memory.

Add more memory.

3. Some applications run in the background and can be
closed by right-clicking on their corresponding icons in
the task tray. To prevent these applications from
launching at startup:

In Windows 7:

a. Go to Start > All Programs > Accessories >
Run

b. Type msconfig, and then press Enter.

c.  On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

In Windows 8:

a. On the Start screen, rightclick, and then select the
All apps icon.

b. Under Windows System, click Run.

c. Type msconfig, and then press Enter.

d. On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

Some software applications, especially games, are stressful on 1. Lower the display resolution for the current application or

the graphics subsystem. consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown.

Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but
LEDs continue flashing).

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and

the processor cooling fan is running.
A fan may be blocked or not turning.

2. Open the access panel, press the power button, and see
OR if the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto

The heat sink is not properly attached to the processor. the system board header.

3. |If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the
hard drive LED turns white, then:

1. If equipped with a voltage selector, check that the
voltage selector (located on the rear of the power supply)
is set to the appropriate voltage. Proper voltage setting
depends on your region.

2. Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on white then:

1. Check that the unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button
cable is properly connected to the system board.

3. Check that the power supply cables are properly
connected to the system board.

4. Check fo see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button assembly.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving power problems

158

Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause

Solution

If equipped with a voltage selector, voltage selector switch on

rear of computer chassis (some models) not switched to
correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but

LEDs continue flashing.)

Cause

Solution

Processor thermal protection activated:
A fan may be blocked or not turning.
OR

The heat sink is not properly attached to the processor.

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

Open the access panel, press the power button, and see
if the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto
the system board header.

If fan a plugged in and not spinning, replace it.
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Power LED flashes Red four times, once every second, followed by a two second pause, and the
computer beeps four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. If equipped with a voltage selector, check that the
voltage selector, located on the rear of the power supply
(some models), is set to the appropriate voltage. Proper
voltage setting depends on your region.

2. Open the access panel and ensure the power supply
cable is seated into the connector on the system board.

3. Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives and expansion cards). Power on the system. If the
system enters POST, then power off and replace one
device at a time and repeat this procedure until failure
occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all
devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.

Solving hard drive problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Windows 7, click Start, click Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then
select File Explorer from the list of applications. In the
left column, expand Computer, right-click on a drive,
select Properties, and then select the Tools tab. Under
Error checking click Check.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.
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Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Windows 7, click Start, expand Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column,
expand Computer, rightclick on a drive, select Properties,
and then select the Tools tab. Under Error checking click
Check.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 174 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-
On Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying fo start from the hard drive but the hard
drive may have been damaged.

1. Perform Drive Protection System (DPS) testing in system
ROM.

System files missing or not properly installed.

1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then
select the File Backup Program option, and then
restore the system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry
in the Storage > Boot Order list.
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Nonsystem disk/NTLDR missing message.

Cause

Solution

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device
Available is selected for the device's SATA port in
Security > Device Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some
models)

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST error messages
on page 190 to determine possible causes for the blinking
red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.

Cause

Solution

Program in use has stopped responding to commands.

1. Use the task manager to close programs that do not
respond.

2. Attempt the normal Windows “Shut Down” procedure. If
this fails, press the power button for four or more
seconds to turn off the power. To restart the computer,
press the power button again.
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Solving media card reader problems
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Media card will not work in a digital camera after formatting it in Windows.

Cause

Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Some

digital cameras use the FAT (FAT16 & FAT12) format and can

not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with

Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause

Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Can not write to the media card.

Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer’'s documentation included with your
card to see if it writable. Refer to the previous section for a list
of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing fo and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Unable to access data on the media card after inserting it into a slot.

Cause

Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold contact
on the correct side. The green LED will light if inserted

properly.
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Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on
the corresponding drive icon, and then select Eject. Pull the
card out of the slot.

In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer,
right-click on the corresponding drive icon, and then select
Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are
not recognized by the computer.

Cause Solution

The operating system needs time to recognize the device if the Wait a few seconds so that the operating system can
reader was just installed into the computer and you are recognize the reader and the available ports, and then
turning the PC on for the first time. recognize the media inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove
it during boot or do not select the option to boot from the
inserfed media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the
boot menu.

3. Change the boot sequence in F10 Computer Setup.

Solving media card reader problems 163



Solving display problems

If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Blank screen (no video).

Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and type your
password (if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan
rate as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting fo resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Monitor cable is plugged info the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer

Monitor settings in the computer are not compatible with the
monitor.

1. In Control Panel, select Category from the View by
list, then under Appearance and Personalization,
select Adjust screen resolution.

To access Control Panel in Windows 7, click Start, and
then select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the
list of applications.

2. Expand the Resolution box, and then use the sliding
control to reset the resolution.

Monitor is configured to use an input that is not active.

Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and seftings.
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Blank screen and the power LED flashes Red five times, once every second, followed by a two second
pause, and the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second
pause, and the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2. Replace the graphics card (if applicable).
3. Replace the system board.

For systems with integrated graphics, replace the system

board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second
pause, and the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with  Disable monitor energy saver feature.
energy saver features enabled.

Solving display problems
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Dim characters.

Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the
monitor.

Blurry video or requested resolution cannot be set.

Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause

Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close fo the
monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.
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“No Connection, Check Signal Cable” displays on screen.

Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause

Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so that
the new settings take effect.

To enter Safe Mode in Windows 7:
1. Restart the computer.

2. Press and hold the F8 key as your computer restarts,
before the Windows logo appears. If the Windows logo
appears, you must restart the computer and try again.

3. On the Advanced Boot Options screen, use the arrow
keys to highlight the safe mode option you want, and
then press Enter.

4. Llog on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

To enter Safe Mode in Windows 8:
1. Press the Windows logo + | to open the Seftings charm.

2. Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options,
select Startup Settings, and then click Restart.

4. Use the function keys or number keys to select the safe
mode option you want.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.
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High pitched noise coming from inside a flat panel monitor.

Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or
unable to center the picture on the screen (flat panel monitors using an analog VGA input connection

only).

Cause Solution

Flat panel monitor's internal digital conversion circuits may be 1. Select the monitor’s Auto-Adjustment option in the
unable to correctly interpret the output synchronization of the monitor’s on-screen display menu.

graphics card.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that will
assist you with the synchronization, go to the following
Web site, select the appropriate monitor, and download
either SP32347 or SP32202: http://www.hp.com
support

Graphics card is not seated properly or is bad (some models). 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.
Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map
info a document.

In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select
Character Map.

In Windows 8, on the Start screen, type ch, and then select

Character Map from the list of applications.
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Solving audio problems

If the computer has audio features and you encounter audio problems, see the common causes and

solutions listed in the following table.

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

NOTE: In Windows 8, the taskbar is available at the bottom
of the Desktop screen.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle.
The speakers should be plugged info the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green
receptacle.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.
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Sound does not come out of the speaker or headphones.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones info the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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There is no sound or sound volume is too low.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving printer problems

If you encounter printer problems, see the documentation that came with the printer and to the common

causes and solutions listed in the following table.

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ >

[printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type
cmd in the Open box, and then click OK.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer selfest.

Solving printer problems

171



Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it
back on.

Printer will not print.

Cause

Solution

The printer may be out of paper.

Check the paper tray and refill it if it is empty.

Solving keyboard and mouse problems
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If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement,
jumpy mouse/keyboard, or no function of mouse/keyboard and external drive.

Cause

Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard USB
receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back
of the computer, and then restart the computer.

Program in use has stopped responding fo commands.

Shut down your computer using the mouse and then restart the
computer.
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Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do
not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause

Solution

The Num Lock key is on.

Press the Num Lock key. The Num Lock light should be off if
you want to use the arrow keys on the keypad. You can
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.
Windows 7:

1. Press the Cirl and Esc keys at the same time (or press the

Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press
Enter.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Windows 8:

1. Press the Windows logo + | to open the Settings charm.

2. Use the arrow keys to select Power, and then press
Enter.

3. Use the arrow keys to select Shut Down, and then
press Enter.

4. After the shutdown is complete, plug the mouse

connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.
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Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting fo resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause

Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.

Solving Hardware Installation Problems
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You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non-plug and play device, you must reconfigure the
computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

A new device is not recognized as part of the system.

Table 8-1 Solving Hardware Installation Problems

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.
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Table 8-1 Solving Hardware Installation Problems (continued)

A new device is not recognized as part of the system.

Cause

Solution

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.

Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or
memory modules were insfalled in the wrong location.

1. Review the documentation that came with the system to
defermine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed.
DIMM1 must be installed before DIMM2, and DIMM3
must be installed before DIMM4.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3.  If you still cannot resolve the issue, contact Customer
Support.

Solving Hardware Installation Problems

175



176

Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 or XMM1 must always be installed.
DIMM1 must be installed before DIMM?2, and DIMM3
must be installed before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card (some models) is not seated properly or is bad,  For systems with a graphics card:

or system board is bad.
1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, replace the system

board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer
beeps ten times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see if
fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.
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Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table 8-2 Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management
> S$5 Maximum Power Savings.

S5 Wake on LAN is disabled (some models). Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on
LAN.

Woake-on-LAN is not enabled. To enable Wake-on-LAN in Windows 7:

1. Select Start > Control Panel > Network and
Sharing Center.

2. Under Tasks, select Manage network
connections.

3. Click Local Area Connection.
4. Click the Properties button.
5. Click the Configure button.

6. Click the Power Management tab, then select
Allow this device to wake the computer.

To enable Wake-on-LAN in Windows 8:

1. From the Start screen, type c, and then select Control
Panel from the list of applications.

2. Select Network and Sharing Center, and then click
the Ethernet link next to the connection.

3. Click the Properties button.
4. Click the Configure button.

5. Click the Power Management tab, then enable the
appropriate Wake-on LAN option.
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Network driver does not detect network controller.

Cause

Solution

Network controller is disabled.

1.

2.

Run Computer Setup and enable network controller.

Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer's Web

site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network controller is disabled.

1.

2,

Run Computer Setup and enable network controller.

Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the
correct operating mode.
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Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end
of the cable.

Ensure that the cable and device at the other end are
operating correcily.

Network controller interrupt is shared with an expansion

board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the
Control Panel and configure the network controller.

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start screen,
type ¢, and then select Control Panel.

Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

Network controller interrupt is shared with an expansion

board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.
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Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery fools in Windows 8.

If necessary, download the softpaq from the web (from a
different computer).

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-  Install a working, industry-standard NIC, or change the boot
standard specifications. sequence fo boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving memory problems

If you encounter memory problems, some common causes and solutions are listed in the following
table.

/\ CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must
unplug the computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.
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E‘%NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.

System will not boot or does not function properly after installing additional memory modules.

Cause

Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.

Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add
more memory to the computer.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving processor problems
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If you encounter processor problems, common causes and solutions are listed in the following table.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously 1. Reinstall the original processor.
enabled on this system.
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Solving CD-ROM and DVD problems

If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

System will not boot from CD-ROM or DVD drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Boot is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 174 section. If the system still
does not recognize the new device, check fo see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-
On Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Solving CD-ROM and DVD problems
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Movie will not play in the DVD drive.

Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove

the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause

Solution

Media is corrupt.

Try different media to confirm whether media is valid.

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine
the type of media being played. If the disc still does not start,
read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

2. Restart the computer and let Windows detect the CD or
DVD driver.
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Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.
2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB flash drive problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is aftached to a USB port that has been hidden in Run the Computer Setup utility and enable USB ports in
Computer Setup. Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup Run the Computer Setup utility and enable booting to
utility. removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution
Flash drive is bootable. Install the flash drive only after the operating system boots.
Flash drive is defective. Try a different flash drive.
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Solving front panel component problems

If you encounter problems with devices connected to the front panel, refer to the common causes and

solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause

Solution

Device is not properly connected.

1.  Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work.

1. |If possible, replace the cable.

2. Restart the computer.

The device is not working.

1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports
are set to Enabled in Security > USB Security.

Solving Internet access problems
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If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet seftings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

Chapter 8 Troubleshooting without diagnostics



Unable to connect to the Internet.

Cause

Solution

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will
be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser remember
some specific information that the Web server can later
retrieve.)

Windows 7:
1. Select Start > Control Panel.
2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Windows 8:

1. From the Start screen, type c, and then select Control
Panel from the list of applications..

2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.

Solving Internet access problems
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Solving software problems

Most software problems occur as a result of the following:

e The application was not installed or configured correctly.

e  There is insufficient memory available to run the application.
e There is a conflict between applications.

e  Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST error messages
on page 190 to determine possible causes.

See the Worldwide Limited Warranty for terms and
conditions.
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Computer will not continue after HP logo screen displays.

Cause

Solution

System files may be damaged.

In Windows 7, use recovery media to scan hard drive for
errors, or use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly. Windows
Startup Repair is one of the recovery tools in the System
Recovery Options menu. You can also create a system repair
disc that contains the System Recovery Options menu. If the
problem is severe enough that Startup Repair doesn't start on
its own and you can't access the System Recovery Options
menu on your computer's hard disk, you can get to the menu
and start Startup Repair by using the Windows installation
disc or a system repair disc that you created earlier.

In Windows 8, use Automatic Repair to fix problems that
might prevent Windows from starting correctly.

To access Automatic Repair:
1. Press the Windows logo + | to open the Seftings charm.

2. Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, and
then select Automatic Repair.

Windows starts Automatic Repair.

4. Select the account to use to begin Automatic Repair, and
type the password for the account.

Windows diagnoses the computer and attempts the
repair it.

“lllegal Operation has Occurred” error message is displayed.

Cause

Solution

Software being used is not Microsoft-certified for your version
of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.

Solving software problems
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POST error messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the probable
source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and
non-error text messages. If a POST error occurs, the screen will display the error message. To manually
switch to the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12).
The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory
test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

@NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 137.

Chapter 9 POST error messages



POST numeric codes and text messages

This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

E’%NOTE: The computer will beep once after a POST text message is displayed on the screen.

Control panel message

Description

Recommended action

101-Option ROM Checksum Error

System ROM or expansion board option
ROM checksum.

-
.

Verify the correct ROM.
2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS. (See Appendix B,
Password security and resetting CMOS

on page 203.)

5. If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure

DMA or timers.

1. Clear CMOS. (See Appendix B,
Password security and resetting CMOS

on page 203.)

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs

Recently added PCl expansion card contains
an option ROM too large to download
during POST.

1. If a PCl expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the internal
NIC from being downloaded during
POST to free more memory for an
expansion card's option ROM. Internal
PXE option ROM is used for booting
from the NIC to a PXE server.

162-System Options Not Set

Configuration incorrect.

RTC (realtime clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Removal and
Replacement section for instructions on
installing a new battery, or contact an
authorized dealer or reseller for RTC battery
replacement.
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Control panel message

Description

Recommended action

163-Time & Date Not Set

Invalid time or date in configuration memory.

RTC (realtime clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used). If
the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

163-Time & Date Not Set

CMOS jumper may not be properly installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error

Memory configuration incorrect.

1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error

RAM failure.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. |f the error persists after replacing
memory modules, replace the system

board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verily proper memory module type.
2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning

Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.
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Control panel message

Description

Recommended action

301-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error

1/O board keyboard controller.

1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error

Keyboard failure.

1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure

Graphics display controller.

1. Reseat the graphics card (if applicable).

2. Clear CMOS. (See Appendix B,
Password security and resetting CMOS

on page 203.)

3.  Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest BIOS
image.

511-CPU, CPUA, or CPUB Fan not Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

513-Front Chassis fan not detected

Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.
2. Reseat fan cable.

3. Replace front chassis fan.

POST numeric codes and text messages
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Control panel message

Description

Recommended action

514-CPU or Chassis Fan not Detected

CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.
2. Reseat fan cable.

3. Replace CPU or chassis fan.

515-Power Supply fan not detected

Power supply fan is not connected or may
have malfunctioned.

1. Reseat power supply fan.
2. Reseat fan cable.

3. Replace power supply fan.

601-Diskette Controller Error

Diskette controller circuitry or floppy drive
circuitry incorrect.

1. Check and/or replace cables.

2. Clear CMOS. (See Appendix B,
Password security and resetting CMOS

on page 203.)

3. Replace diskette drive.

4. Replace the system board.

605-Diskette Drive Type Error

Mismatch in drive type.

1. Disconnect any other diskette controller
devices (tape drives).

2. Clear CMOS. (See Appendix B,
Password security and resetting CMOS

on page 203.)

660-Display cache is detected unreliable

Integrated graphics controller display cache

is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected

Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCl Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system
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1151-Serial Port A Address Conflict Detected

Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password security and resetting CMOS

on page 203.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
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Control panel message

Description

Recommended action

1152-Serial Port B Address Conflict Detected

Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password security and resetting CMOS

on page 203.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected

Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Appendix B,
Password security and resetting CMOS

on page 203.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct

error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

2. Apply hard drive firmware patch
if applicable. (Available at

http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA O and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer Setup,
change Storage > Storage Options >
SATA Emulation to IDE, and select File >
Save Changes and Exit. Reenter
Computer Setup and select Security >
Drivelock Security. For each listed
Drivelock-capable SATA device, ensure
Drivelock is Disabled. Lastly, change
Storage > Storage Options > SATA
Emulation back fo RAID and select File >
Save Changes and Exit.

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1. Upgrade BIOS to proper version.

2. Change the processor.
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Control panel message

Description

Recommended action

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the computer,
restore the original memory
configuration, and reboot the computer.

4. |f the error persists, replace the system

board.

2201-MEBx Module did not checksum
correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. |f the error persists, replace the system

board.

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, resseat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. |f the error persists, replace the system

board.

2203-Setup error during MEBx execution

MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4. | the error persists, replace the system

board.
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Control panel message

Description

Recommended action

2204-Inventory error during MEBx execution

BIOS information passed to the MEBx
resulted in a failure.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2205-Interface error during MEBx execution

MEBx operation experienced a hardware
error during communication with ME.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version.

3.  If the error still persists, replace the
system board.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMMT1 is not installed.

Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning
will not allow BIOS to update provision file

properly.

1. Try a different USB key device for
provisioning.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  |If the error still persists, replace the
system board.

2217-ME Firmware Version request failure

ME firmware is not properly responding to
BIOS query for version information.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

2218-ME Firmware Version should be
updated

ME firmware must be updated to match
current functionality contained in the system
BIOS.

1. Update to the latest ME firmware
version.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.

3.  If the error still persists, replace the
system board.

2219-USB Key Provisioning file has invalid
header identifier

Provisioning file contained on the USB key
has been corrupted or is not a valid version
for the current ME firmware.

1. Recreate the provisioning file using third
party management console software.

2. |If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3.  If the error still persists, replace the
system board.

POST numeric codes and text messages

197



Control panel message

Description

Recommended action

2220-USB Key Provisioning file has
mismatch version

Provisioning file contained on the USB key is
not a valid version for the current ME
firmware.

1. Reboot the computer.

2. |f the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. |If the error still persists, replace the
system board.

2230-General error during MEBx execution

Error occurred during MEBx execution which
fails into the “General” grouping. Status
information displayed along with the error
provides further clarity into the failure. MEBx
handles transference of information between
the system BIOS and ME firmware.

1. Reboot the computer.

2. |f the error persists, update to the latest
BIOS version and ME firmware version.

3. |If the error still persists, replace the
system board.

2231-ME error during MEBx execution

Error occurred during MEBx execution which
fails into “ME” grouping.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

2232-AMT error during MEBx execution

Error occurred during MEBx execution which
fails into “AMT” grouping.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  |If the error still persists, replace the
system board.

2233-HECI error during MEBx execution

Error occurred during MEBx execution which
fails into “MEIl or HECI” grouping.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

2239-ME image lock failure

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred after the ME firmware update
process in which the BIOS could not relock
the ME firmware region.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  |If the error still persists, replace the
system board.

2240-ME image unlock failure

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred prior to the ME firmware update
process in which the BIOS could not unlock
the ME firmware region.

1. Reboot the computer.

2.  |f the error persists, update to the latest
BIOS version and ME firmware version.

3. |If the error still persists, replace the
system board.

Invalid Electronic Serial Number

Electronic serial number is missing.

Enter the correct serial number in Computer
Setup.
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Control panel message Description Recommended action

Network Server Mode Active and No Keyboard failure while Network Server 1. Reconnect keyboard with computer
Keyboard Attached Mode enabled. turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.

Interpreting POST diagnostic front panel LEDs and
audible codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

E’%NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the

computer and refer to the following table to determine the front panel LED codes.
Recommended actions in the following table are listed in the order in which they should be performed.

Not all diagnostic lights and audible codes are available on all models.

Activity Beeps Possible cause Recommended action
White Power LED On. None Computer on. None
White Power LED flashes every None Computer in Suspend to None required. Press any key or move the mouse
two seconds. RAM mode (some models  to wake the computer.
only) or normal Suspend
mode.
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Activity Beeps Possible cause Recommended action
Red Power LED flashes two 2 Processor thermal 1. Ensure that the computer air vents are not
times, once every second, protection activated: blocked and the processor cooling fan is
followed by a two second running.
pause. Beeps stop after fifth A fan may be blocked or
iteration but LEDs confinue until not turning. 2. Open hood, press power button, and see if
problem is solved. the processor fan spins. If the processor fan
OR is not spinning, make sure the fan's cable is
] plugged onto the system board header.
The heat sink/fan
assembly is not properly 3. [Iffanis plugged in, but is not spinning, then
attached fo the processor. replace heat sink/fan assembly.
4. Contact an authorized reseller or service
provider.
Red Power LED flashes three 3 Processor not installed (not 1. Check to see that the processor is present.
times, once every second, an indicator of bad
followed by a two second processor). 2. Reseat the processor.
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.
Red Power LED flashes four 4 Power failure (power 1. Open the hood and ensure the 4 or 6-wire
times, once every second, supply is overloaded). power supply cable is seated into the
followed by a two second connector on the system board.
pause. Beeps stop after fifth
iteration but LEDs continue until 2. Check if a device is causing the problem by
problem is solved. removing ALL attached devices (such as
hard, diskette, or optical drives, and
expansion cards). Power on the system. If
the system enters the POST, then power off
and replace one device at a time and repeat
this procedure until failure occurs. Replace
the device that is causing the failure.
Continue adding devices one at a time to
ensure all devices are functioning properly.
3. Replace the power supply.
4. Replace the system board.

Red Power LED flashes five 5
times, once every second,
followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

Pre-video memory error.

CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

1.

2.

Reseat DIMMs.

Replace DIMMs one at a time to isolate the
faulty module.

Replace third-party memory with HP
memory.

Replace the system board.
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Activity Beeps Possible cause Recommended action
Red Power LED flashes six 6 Pre-video graphics error.  For systems with a graphics card:
times, once every second,
followed by a two second 1. Reseat the graphics card.
pause. Beeps stop after fifth | : . 4
iteration but LEDs continue until 2. Replace the graphics card.
problem is solved. 3. Replace the system board.
For systems with integrated graphics, replace the
system board.
Red Power LED flashes seven 7 System board failure Replace the system board.
times, once every second, (ROM detected failure
followed by a two second prior fo video).
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.
Red Power LED flashes eight 8 Invalid ROM based on 1. Reflash the system ROM with the latest BIOS
times, once every second, bad checksum. image.
followed by a two second
pause. Beeps stop after fifth 2. Replace the system board.
iteration but LEDs continue until
problem is solved.
Red Power LED flashes nine 9 System powers on but is 1. Check that the voltage selector, located on
times, once every second, unable to boot. the rear of the power supply (some models),
followed by a two second is set fo the appropriate voltage. Proper
pause. Beeps stop after fifth voltage setting depends on your region.
iteration but LEDs continue until
problem is solved. 2. Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.
3. Replace the system board.
4. Replace the processor.
Red Power LED flashes ten 10 Bad option card. 1. Check each option card by removing the

times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

card (one at a time if multiple cards), then
power on the system to see if fault goes
away.

2. Once a bad card is identified, remove and
replace the bad option card.

3. Replace the system board.
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Activity Beeps

Possible cause

Recommended action

Red Power LED flashes eleven 11
times, once every second,

followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

The current processor does
not support a feature
previously enabled on this
system.

1. Reinstall the original processor.

System does not power on and None
LEDs are not flashing.

System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns white, the
power button is working correctly. Try the
following:

1. Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.

OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
white then:

1. Check that the unit is plugged into a
working AC outlet.

2. Open hood and check that the power button
harness is properly connected to the system

board.

3. Check that both power supply cables are
properly connected fo the system board.

4. Check fo see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button harness. If the
problem persists, replace the system board.

5. If the 5V_aux light on the system board is
not turned on, remove the expansion cards
one at a time until the 5V_aux light on the
system board turns on. It the problem
persists, replace the power supply.
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10 Password security and resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password,
any user can access all the information on the computer except Computer Setup. When you establish
only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the setup password will
give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.

/\ CAUTION:  Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 137 for information on
backing up the CMOS settings.
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Resetting the password jumper
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CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setu
Y g Y P P )4 9 P
password or the power-on password, the computer is inaccessible and can no longer be used.

Enabling the stringent password disables the ability to reset the password by moving the jumper on the
system board.

If you lose or forget the password, the system board must be replaced. This scenario is not covered
under warranty.

To prevent the computer from becoming permanently unusable, record your configured setup password
or power-on password in a safe place away from your computer. Without these passwords, the
computer cannot be unlocked.

To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

/\ WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

/\ CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage fo the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Llocate the header and jumper.

%/%"NOTE: The password jumper is green so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the lllustrated Parts & Service Map
(IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so that
it does not get lost.

6. Replace the computer cover or access panel.

7. Reconnect the external equipment.
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8. Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 1
and 2, then repeat steps 6 through 8. Establish the new passwords in Computer Setup.

Clearing and resetting the CMOS

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during
POST.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

/A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

/\ CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the computer cover or access panel.

/\ CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important
to back up the computer CMOS settings before resetting them in case they are needed later. Back
up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 137 for
information on backing up the CMOS settings.
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4. locate, press, and hold the CMOS button in for five seconds.

2 NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

2 NOTE: For assistance locating the CMOS button and other system board components, see the
llustrated Parts & Service Map (IPSM).

5. Replace the computer cover or access panel.
6. Reconnect the external devices.

7. Plug in the computer and turn on power.

2 NOTE:  You will receive POST error messages after clearing CMOS and rebooting advising you
that configuration changes have occurred. Use Computer Setup fo reset any special system setups
along with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 137.
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11 HP PC Hardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP
includes on all products. This tool can even be used if the computer will not boot to the operating
system.

Why run HP PC Hardware Diagnostics

The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite
the support process when issues are found. The tools save time by pinpointing the component that
needs to be replaced.

e Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

e Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.

How to access and run HP PC Hardware Diagnostics

You can run the diagnostics from one of three places, depending on your preference and the health of
the computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.
2. Press F2 or select Diagnostics (F2).
Pressing F2 signals the system to search for the diagnostics in the following locations:

a. A connected USB drive (to download the diagnostics tools to a USB drive, see the instructions
in Downloading HP PC Hardware Diagnostics to a USB device on page 208)

b. The hard disk drive

c. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible
only if the USB or hard disk drive versions are not detected
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Downloading HP PC Hardware Diagnostics to a USB

device
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1.

A o o

Go to http://www.hp.com.

Click the Support & Drivers link.

Select the Drivers & Software tab.

Enter the product name in the text box and click Search.
Select your specific computer model.

Select your operating system.

In the Diagnostic section, click the HP UEFI Support Environment link. This link provides
additional information.

-0or -

Click the Download button and select Run. The download includes instructions (in English) on
how to install the tools on the USB device.

2»NOTE: HP diagnostic solutions are developed fo test components typically included on HP products.
They may not diagnose all third-party accessories that can be added to the system.

Chapter 11 HP PC Hardware Diagnostics


http://www.hp.com

12 System backup and recovery

Backing up, restoring, and recovering in Windows
8.1 or Windows 8

Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:
e  Creating recovery media and backups

e  Restoring and recovering your system

22 NOTE: This section describes an overview of backing up, restoring, and recovering options. For more
details about the tools provided, see Help and Support. From the Start screen, type help, and then
select Help and Support.

Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create recovery media. This step creates a backup of
the recovery partition on the computer. The backup can be used to reinstall the original operating
system in cases where the hard drive is corrupted or has been replaced.

You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot
a computer that is unable to start. The USB flash drive can be used to reinstall the original
operating system and the programs that were installed at the factory.
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2 NOTE: Any information on the USB flash drive will be erased before the recovery media is
created.

e To create the Windows 8.1 recovery media, from the Start screen, type recovery drive,
then click on Create a recovery drive. Follow the on-screen instructions to continue.

e To create the Windows 8 recovery media, from the Start screen, type recovery drive,
and then click on Settings, then click on Create a recovery drive. Follow the on-screen
instructions to continue.

2. Use the Windows tools to create system restore points and create backups of personal
information. For more information and steps, see Help and Support. From the Start screen, type
help, and then select Help and Support.

Restoring and recovering using Windows tools
Windows offers several options for restoring from backup, refreshing the computer, and resetting the

computer fo its original state. For more information and steps, see Help and Support. From the Start
screen, type help, and then select Help and Support.

Using Reset when the system is not responding

@NOTE: You may be prompted by User Account Control for your permission or password when you
perform certain tasks. To continue a task, select the appropriate option. For information about User
Account Control, see Help and Support. From the Start screen, type help, and then select Help and
Support.

@IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any
personal information you wish to retain.

If Windows recovery steps are not working and the system is not responding, use these steps to start
Reset:

1. |If possible, back up all personal files.
2. |If possible, check for the presence of the HP Recovery partition:
e  For Windows 8.1, from the Start screen, type pc, and then select This PC.

e  For Windows 8, from the Start screen, type c, and then select Computer.

E’%NOTE: It the HP Recovery partition is not listed, or you cannot check for its presence, you must
recover using the recovery media you created; see Recovery using the Windows recovery USB
flash drive on page 211. Or you must use the Windows operating system media and the Driver
Recovery media (purchased separately); see Recovery using Windows operating system media
(purchased separately) on page 211.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the HP logo is
displayed. The computer Startup Menu displays.

4. Press {11 to select the System Recovery option.

5. Choose your keyboard layout.
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6. Select Troubleshoot.
7. Select Reset.

8. Follow the on-screen instructions to continue.

Recovery using the Windows recovery USB flash drive

To recover your system using the recovery USB flash drive you previously created:

r__":"/%?NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see
Recovery using Windows operating system media (purchased separately) on page 211.

1. If possible, back up all personal files.
2. Insert the recovery USB flash drive you created into a USB port on your computer.

3. Restart the computer and as soon as you see the HP logo screen, press {9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press
Enter to boot from that device.

Choose your keyboard layout.
Select Troubleshoot.

4,
5.
6. Select Refresh your PC.
7.

Follow the on-screen instructions.

Recovery using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. Go to http://www.hp.com/support,
select your country or region, and follow the on-screen instructions.

/\ CAUTION: Using Windows operating system media completely erases the hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using Windows operating system media:

E%?NOTE: This process takes several minutes.

1. [If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows operating system
media to install the operating system.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.
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Atter the repair is completed and the Windows desktop appears:

1.
2,

Remove the Windows operating system media, and then insert the Driver Recovery media.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Backing up, restoring, and recovering in Windows 7

Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

Creating recovery media and backups

Restoring and recovering your system

2»NOTE: This section describes an overview of backing up, restoring, and recovering options. For more
details about the Windows Backup and Restore tools provided, see Help and Support. To access Help
and Support, select Start > Help and Support.

Recovery after a system failure is only as good as your most recent backup.

1.

After you successfully set up the computer, create recovery media. This media can be used to
reinstall the original operating system in cases where the hard drive is corrupted or has been
replaced. See Creating recovery media on page 212.

As you add hardware and software programs, create system restore points. A system restore point
is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time.
A system restore point contains information that Windows uses, such as registry settings. Windows
creates a system restore point for you automatically during a Windows update and during other
system maintenance (such as a software update, security scanning, or system diagnostics). You
can also manually create a system restore point at any time. For more information and steps for
creating specific system restore points, see Help and Support. To access Help and Support, select
Start > Help and Support.

As you add photos, video, music, and other personal files, create a backup of your personal
information. If files are accidentally deleted from the hard drive and they can no longer be
restored from the Recycle Bin, or if files become corrupted, you can restore the files that you
backed up. In case of system failure, you can use the backup files to restore the contents of your
computer. See Backing up your information on page 215.

2% NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Creating recovery media

212

After you successfully set up the computer, create recovery media. The media can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced.
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There are two types of recovery media. To determine which steps to follow for your computer:
1. Click the Start button.

2. Click All Programs.

e If Security and Protection is listed, continue with the steps in Creating recovery media
using HP Recovery Manager (select models only) on page 213.

e If Productivity and Tools is listed, continue with the steps in Creating recovery discs with
HP Recovery Disc Creator (select models only) on page 214.

Creating recovery media using HP Recovery Manager (select models only)

e To create recovery discs, your computer must have a DVD writer. Use DVD+R or DVD-R discs
(purchased separately). The discs you use will depend on the type of optical drive you are using.

@NOTE: DVD+R DL, DVD-R DL, or DVD+RW disc are not supported.

e  You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.

e If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

e  The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs needed
to make the set. If you are using a USB flash drive, the program will tell you the size of the drive
required to store all the data (minimum of 8 GB).

2»NOTE: The process of creating recovery media is lengthy. You can quit the process at any time.
The next time you initiate the process, it resumes where it left off.

2»NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.

To create recovery discs:
1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click HP Recovery Media Creation. If prompted, click Yes to allow the
program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc after you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

E’%NOTE: You must use a USB flash drive with a capacity of at least 8 GB.
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E/?’NOTE: Recovery Media Creation formats the USB flash drive, deleting any files on it.

1. Close all open programs.
2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much storage
is required to create the recovery drive. If the USB flash drive does not have enough storage
capacity, it will appear grayed out, and you must replace it with a larger USB flash drive. Click
Next.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

Creating recovery discs with HP Recovery Disc Creator (select models only)

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery discs
on select models. After you successfully set up the computer, you can create recovery discs using HP
Recovery Disc Creator. The recovery discs allow you to reinstall your original operating system as well
as select drivers and applications if the hard drive becomes corrupted. HP Recovery Disc Creator
creates two kinds of recovery discs:

e  Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

e  Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

To create recovery discs, your computer must have a DVD writer. Use any of the following types of
discs (purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use
will depend on the type of optical drive you are using.

Creating recovery discs
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=»NOTE: The Windows 7 operating system DVD can be created only once. The option to create that
media will not be available after you create a Windows DVD.

To create the Windows DVD:
1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

Select Windows disk.

From the drop-down menu, select the drive for burning the recovery media.

Lol S

Click the Create button to start the burning process. Label the disc after you create it, and store it
in a secure place.
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After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4

Click the Create button to start the burning process. Label the disc after you create it, and store it
in a secure place.

Backing up your information

You should create your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. Your initial and subsequent backups allow you to restore your data and settings if a
failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e  Back up templates that are stored in their associated directories.

e Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

e When backing up to discs, number each disc after removing it from the drive.

2% NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.

E/?‘NOTE: You may be prompted by User Account Control for your permission or password when you
perform certain tasks. To continue a task, select the appropriate option. For information about User
Account Control, see Help and Support: Select Start > Help and Support.

To create a backup using Windows Backup and Restore:

|‘__":"/;’NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.
2. Follow the on-screen instructions to set up your backup.
System Restore
If you have a problem that might be due to software that you installed on your computer, or if you want

to restore the system to a previous state without losing any personal information, use System Restore to
return the computer to a previous restore point.

@NOTE: Always use this System Restore procedure before you use the System Recovery feature.

Backing up, restoring, and recovering in Windows 7 215



To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen

instructions.

System Recovery

WARNING! This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed after
purchase. Any personal files must be restored from backups you made.

If you were not able to create system recovery DVDs or USB flash drive, you can order a recovery disc
set from support. Go to http://www.hp.com/support, select your country or region, and follow the on-
screen instructions.

2»NOTE: Always use the System Restore procedure before you use the System Recovery program. See
System Restore on page 215.

You must choose one of the following methods to perform a System Recovery:

e Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 216 or System Recovery when Windows is not responding on page 217.

e Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. See System Recovery using recovery
media (select models only) on page 217.

System Recovery when Windows is responding

/\ CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

@NOTE: In some cases, you must use recovery media for this procedure. If you have not already
created this media, follow the instructions in Creating recovery media on page 212.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery:

1. Turn off the computer.
2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.
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4. When Windows has loaded, click the Start button, and then click All Programs.
e If Security and Protection is listed, continue with step 5.

e If Productivity and Tools is listed, follow the steps in System Recovery when Windows is
not responding on page 217.

5. Click Security and Protection, click Recovery Manager, and then click Recovery
Manager. If prompted, click Yes to allow the program to continue.

6. Under I need help immediately, click System Recovery.
7. Select Yes, and then click Next. Your computer restarts.

8. When the computer restarts, you will see the Recovery Manager welcome screen again. Under |
need help immediately, click System Recovery. If you are prompted to back up your files,
and you have not done so, select Back up your files first (recommended), and then click
Next. Otherwise, select Recover without backing up your files, and then click Next.

9. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

10. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

/\ CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.
2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.
3. Press the power button to turn on the computer.
4

As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is loading Files... message appears on the screen.

o

At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery using recovery media (select models only)

Use the steps provided in this section if you created recovery media using Creating recovery media
using HP Recovery Manager (select models only) on page 213. If you used HP Recovery Disc Creator
to create a Windows 7 operating system DVD and a Driver Recovery DVD, use the steps in Using HP
Recovery Disc operating system discs (select models only) on page 218.

CAUTION: System Recovery deletes all data and programs you have created or installed. Back u
Y Y prog Y p
any important data to a CD or DVD or to a USB flash drive.
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To perform a System Recovery using recovery media:

1. If you are using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the
tray. If you are using a recovery USB flash drive, insert it into a USB port.

2. Click the Start button, and then click Shut Down.
or

If the computer is not responding, press and hold the power button for approximately 5 seconds or
until the computer turns off.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer, and press Esc as the computer is powering on to
display the startup menu.

5. Use the arrow keys to select the boot menu, and press Enter. Use the arrow keys to select the
location where the recovery media is inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under | need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9.  When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.

Using HP Recovery Disc operating system discs (select models only)

218

Use the steps provided in this section if you used HP Recovery Disc Creator to create a Windows 7
operating system DVD and a Driver Recovery DVD. If you created recovery media using Creating
recovery media using HP Recovery Manager (select models only) on page 213. use the steps in System
Recovery using recovery media (select models only) on page 217.

If you cannot use the recovery discs you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and
repair the operating system.

To order a Windows 7 operating system DVD, contact support. Go to http://www.hp.com/support,
select your country or region, and follow the on-screen instructions.

/\ CAUTION: Using a Windows 7 operating system DVD completely erases the hard drive contents

and reformats the hard drive. All files that you have created and any software that you have installed
on the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:
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E’%NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

@NOTE: If the computer does not boot to the DVD, restart the computer and press Esc as the
computer is powering on to see the startup menu. Use the arrow keys to select the boot menu and
press Enter. Use the arrow keys to select the location where the recovery DVD is inserted. Press
Enter fo boot from that device.

When prompted, press any keyboard key.

Follow the on-screen instructions.

3.

4,

5. Click Next.
6. Select Install now.

7. Follow the on-screen instructions.
After the repair is completed:

1. Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Follow the on-screen instructions to install the Hardware Enabling Drivers first, and then install
Recommended Applications.
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A Battery replacement

The battery that comes with the computer provides power to the realtime clock. When replacing the
battery, use a battery equivalent to the battery originally installed in the computer. The computer comes
with a 3-volt lithium coin cell battery.

/\ WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60°C (140°F).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

/\ CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

E/?’NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com

recycle.

1. Remove/disengage any security devices that prohibit opening the computer.
2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

/\ CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5. Remove the access panel.
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6.

7.

Locate the battery and battery holder on the system board.

%’NOTE: On some computer models, it may be necessary to remove an internal component to

gain access to the battery.

Depending on the type of battery holder on the system board, complete the following instructions
to replace the battery.

Type 1

a. Llift the battery out of its holder.

b. Slide the replacement battery into position, positive side up. The battery holder automatically
secures the battery in the proper position.

Type 2

a. To release the battery from its holder, squeeze the metal clamp that extends above one edge
of the battery. When the battery pops up, lift it out (1).

b. To insert the new battery, slide one edge of the replacement battery under the holder’s lip
with the positive side up. Push the other edge down until the clamp snaps over the other edge
of the battery (2).

Type 3

a. Pull back on the clip (1) that is holding the battery in place, and remove the battery (2).
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b. Insert the new battery and position the clip back into place.

+

=2

E‘/?"NOTE: After the battery has been replaced, use the following steps to complete this procedure.

8. Replace the access panel.
9. Plug in the computer and turn on power to the computer.
10. Reset the date and time, your passwords, and any special system setups using Computer Setup.

11. Lock any security devices that were disengaged when the access panel was removed.
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B Power cord set requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC.
Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

/\ WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese power cord requirements

For use in Japan, use only the power cord received with this product.

/\ CAUTION: Do not use the power cord received with this product on any other products.

General requirements 223



Country-specific requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW ltaly (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) uL

Germany (1) VDE

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug must
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C Specifications

Microtower specifications

Chassis

Height 14.05 in 357 mm
Width 7.2in 182.9 mm
Depth 15.82 in 402 mm
Approximate Weight 15.75 b 7.15kg

Temperature Range
Operating 50° to 95°F 10° to 35°C

Nonoperating -22° to 140°F -30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no
direct sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and
number of options installed.

Relative Humidity (noncondensing)

Operating 10-90% 10-90%

Nonoperating (38.7°C max wet bulb) 595% 5-95%

Maximum Altitude (unpressurized)

Operating 10,000 ft 3048 m
Nonoperating 30,000 ft 9144 m
Power Supply

Operating Voltage Range 90-264 VAC

Rated Voltage Range' 100-240 VAC

Rated Line Frequency 50-60 Hz

Operating Line Frequency 47-63 Hz
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Standard Efficiency 300W active PFC(230 VAC input only)
High Efficiency 300W active PFC EStar 6

82/85/82% efficient at 20/50/100% load (230V)

Rated Input Current 4A

1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements
for use in the countries of the European Union. The active power factor corrected power supply also has the added benefit of
not requiring an input voltage range select switch.

SFF specifications

Chassis (in the desktop position)

Height 3.93in 100 mm
Width 13.26in 33.7 cm
Depth 14.98 in 380 mm
Approximate Weight 13.01b 5.9 kg
Weight Supported (maximum distributed load in desktop position) 77 b 35 kg

Temperature Range
Operating 50° to 95°F 10° to 35°C

Nonoperating -22° to 140°F -30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 fi) above sea level; no direct
sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options
installed.

Relative Humidity (noncondensing)

Operating 10-90% 10-90%

Nonoperating (38.7°C max wet bulb) 595% 5-95%

Maximum Altitude (unpressurized)

Operating 10,000 ft 3048 m
Nonoperating 30,000 ft 9144 m
Power Supply

Operating Voltage Range 90-264 VAC

Rated Voltage Range' 100-240 VAC

Rated Line Frequency 50-60 Hz

Operating Line Frequency 47-63 Hz
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Standard Efficiency

High Efficiency

240W active PFC
240W active PFC

82/85/82% efficient at 20/50/100% load
(230V)

Rated Input Current

4A

1

This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements
for use in the countries of the European Union. The active power factor corrected power supply also has the added benefit of

not requiring an input voltage range select switch.

SFF specifications
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